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Administration Overview 

The Administration module in EnterpriseTrack allows you to manage your deployment by 
changing various aspects of the application. Access to the administration and configuration UI is 
controlled through permissions. The Administration link is displayed only if you have permissions 
to access at least one administration section. You can use following tabs on the Administration 
module to set and manage EnterpriseTrack: 

 Application Configuration: From this tab you can access links to configure the following: 
projects, project settings, organizational hierarchy, status reports, calendars, routing, custom 
fields, classification fields, resource pulldown, alignment pulldown, global pulldown, and 
initiative pulldown. 

 Resource & Security Admin: From this tab you can access links to resource administration, 
resource configuration, resource admin reports, timesheet settings, security administration, 
and configuring temporary administrators. 

 Finance: From this tab you access all finance management links. 

 General Settings: From this tab you can access links to configure you company settings, 
help settings, notifications/emails, storyboard, mobile, and report, listing page, and search 
settings. 

 Data Import & Export: From this tab you can access links to data import, data export, and 
download integration templates 

 Background Jobs: From this tab you can view the submission status of all rate change 
requests. 

 Updates: From this tab you can view the updates that were made to the system. You can 
view a list of release upgrades, hot patches, and service packs that were applied. It also 
displays the mode changes, customizations, and the new initiatives that were added. This is 
a ready-only tab. 

Getting Around in the Administration Module 

Access 

To Access the Administration module, click on the Administration link in the Left navigation bar 
or select Go To > Administration from the Top Navigation Bar to access the Administration 
User Interface (UI). 

Navigation 

Using the Top Navigation Bar
The Top Navigation bar is active when you log into the system. It contains the Application Level 
menu and depending on the context, a Module Level menu. 

 The Home button takes you to your default home page. When the Left Navigation bar is 
hidden, it is displayed on the blue banner. When the Left Navigation bar is displayed, the 
Home button is displayed on the Left Navigation bar. 
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 The Go To menu provides access to all major modules within the EnterpriseTrack system. 
The items displayed in this menu depend on the features enabled for your deployment and 
your permissions. 

 The Create menu displays menu options to create a new project, proposal, idea, program, 
resource or message, etc. 

 The My EnterpriseTrack (terminology is configurable) menu displays options that take you 
to your specific actions and settings. It shows your work (all open actions on Projects, 
Proposals, Ideas etc. that are assigned to you), your messages, certifications, permission, 
profile, preferences and passwords. 

 The View menu allows you to display toolbars at the Top banner, and Left Navigation bar. 
You can also save your settings. 

 The project type ahead text box provides easy navigation to any project in the system. In the 
text box Type Project ID or name, you can type the Project ID or any part of the name and 
as you type, the system gives you project choices that match the ID or name you are typing. 

 The Advanced Search menu gives you different ways for searching the system. You can 
search on projects, proposals, documents, etc. 

 From the Help menu, you can launch the online help in a new window, or launch UPK. 

 Click on the Logout button at any time to log out. 

Using the Left Navigation Bar

To display the Left Navigation bar, from the Top Navigation Bar select the View menu and 
choose Display Left Navigation. Select if you want to display icons only or icons and text. The 
Left Navigation bar provides access to all modules in the EnterpriseTrack system. The list of 
menu items displayed depends on the features enabled for your deployment and your 
permissions. As you drag the mouse over these items, you will see the clickable items change 
color. Current selections are always highlighted. Clicking on any of these options typically takes 
you to a listing page with summary information. 

Use the  icon on top of the Left Navigation bar to expand and collapse the Left Navigation 
bar. To return to the main Administration menu from any of the above sections, click the 
Administration link in the Left Navigation bar. 

Important! 

Do not use the browser's Back and Forward buttons to navigate to a 
different page. Use the left navigation bar and/or the buttons provided 
within Enterprise Track. When you first log into the system, the left and 
top navigation bars will be active. Once you enter a specific page within 
a module, you will find that all the navigation buttons are disabled. 

Sorting 

There are several pages within the Administration module where lists of items are displayed. 
The lists within EnterpriseTrack can be sorted by clicking the column title. 
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Privacy Configuration 

In This Section 

About Personal Information ..................................................................................... 11 
Your Responsibilities ............................................................................................... 12 

About Personal Information 

Personal information (PI) is any piece of data which can be used on its own or with other 
information to identify, contact, or locate an individual or identify an individual in context. This 
information is not limited to a person's name, address, and contact details. For example a 
person's IP address, phone IMEI number, gender, and location at a particular time could all be 
Personal information. Depending on local data protection laws, organizations might be 
responsible for ensuring the privacy of PI wherever it is stored, including in backups, locally 
stored downloads, and data stored in development environments. 

About Consent Notices 

Consent notices inform users how Personal information (PI) is collected, processed, stored, and 
transmitted, along with details related to applicable regulations and policies. Consent notices 
also alert users that the action they are taking may risk exposing PI. EnterpriseTrack helps you 
to ensure that you have requested the appropriate consent to collect, process, store, and 
transmit the PI your organization holds as part of EnterpriseTrack data. 

Consent notices should: 

 be written in clear language which is easy to understand. 

 provide the right level of detail. 

 identify the purpose and legal basis for your collection, processing, storage, and 
transmission of PI. 

 identify whether data will be transferred to named third parties. 

 identify PI categories and list the data which will be collected, processed, stored, and 
transmitted. 

Cookies Usage 

When using EnterpriseTrack, the server may generate cookies and send them to the user’s 
browser. The user’s machine stores the cookies, either temporarily by the browser, or 
permanently until they expire or are removed manually. Cookies might store Personal 
Information (PI). 

We might use cookies for authentication, session management, preferences, and provide 
documentation support.  
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Your Responsibilities 

Information security and privacy laws can carry heavy penalties and fines for organizations 
which do not adequately protect PI they gather and store. If these laws apply to your 
organization, it is your responsibility to configure consent notices before they are required. You 
should work with your data security and legal teams to determine the wording of the consent 
notices you will configure in EnterpriseTrack. 

If a consent notice is declined, it is your responsibility to take any necessary action. For 
example, you may be required to ensure that the data is not stored or shared. 

In This Section 

Personal Information (PI) in EnterpriseTrack ........................................................... 12 
Security ................................................................................................................... 12 
Enabling the Privacy and Security Feature .............................................................. 13 
Working with Privacy Configurations ....................................................................... 14 
Administering Privacy Configurations ...................................................................... 17 

Personal Information (PI) in EnterpriseTrack 

PI might be visible in multiple areas of EnterpriseTrack including but not limited to user 
administration, resource and role administration, assignments, documents, reports, issues, risks, 
user-defined fields, and timesheets. 

PI might be at risk of exposure in multiple areas of EnterpriseTrack including but not limited to 
project export, downloaded tables, reports, documents, API, exported BI data, emails, and 
mobile. 

Security 

Contact Oracle support to request logs specific to your account. You can only request logs for 
the last 90 days, logs beyond 90 days are automatically purged.  

Depending on the size of the logs, they are either uploaded to your support ticket or shipped to 
your destination via ftp or sftp. 

Authentication 

To validate user identities, EnterpriseTrack supports (User ID and password) forms-based 
authentication, LDAP/Active Directory-based authentication, and various Single Sign-On 
(SSO)-based authentication mechanisms, including those based on SAML. 

 User Password is the default mode for EnterpriseTrack. In User Password mode, the 
EnterpriseTrack database acts as the authority and the application handles the 
authentication of the user who is logging into that application. 

 Active Directory (AD)/LDAP EnterpriseTrack can use an AD/LDAP server for user 
authentication. The server's details, such as its LDAP Provider URL, must be specified in 
EnterpriseTrack. 
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 Single Sign-On (SSO) EnterpriseTrack supports SAML-based SSO  and can use the user's 
Identity Provider to authenticate users. No additional SAML service provider software is 
needed. 

Authorization 

Grant authorization carefully to all appropriate EnterpriseTrack users. To protect against 
unauthorized access to your critical information, EnterpriseTrack supports fine-grained 
Roles-Based Authorization to control access to various objects and operations within the 
application. 

To help you with security planning, EnterpriseTrack roles/permissions settings are configured by 
the Solution Architect using the requirements collected from the customer. These are detailed in 
the EnterpriseTrack User's Guide and the EnterpriseTrack Application Administrator's Guide. 

Confidentiality 

Confidentiality ensures only authorized users see stored and transmitted information. In addition 
to the documentation included with other applications and hardware components, follow the 
EnterpriseTrack-specific guidance below: 

 For data in transit, use TLS with recommended and strong cipher suites to protect network 
connections among modules. If you use LDAP or SSO authentication, ensure you use 
LDAPS to connect to the directory server. 

 For data at rest, refer to the documentation included with the database server for instructions 
on securing the database. 

 For encryption in transit, use HTTPS by default. 

 For encryption at rest, Total Data Encryption (TDE) in Oracle DB is available on demand for 
all new Cloud customer deployments.  Existing Cloud customers may need to go through a 
migration in order to apply TDE if it is not applied already. 

Enabling the Privacy and Security Feature 

When the Privacy and Security feature is enabled, the following features and modules that allow 
the import or export of PI data are disabled: 

 Data export 

 Cron job/scheduled reports 

 Data import/export 

 Export listing page content 

 Integration APIs 

 Microsoft Project (MSP) data export 

 Reports 

You can choose to enable one or more of these features or modules from the Privacy Feature 
Settings page. For more information, see topic Enabling or Disabling Privacy Feature Settings.  
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After you enable the privacy and security feature, the Privacy Configuration tab  is displayed in 
the Administration console. The settings under this tab will allow you configure and manage your 
organization's privacy settings.  

Notes: 

 Ensure that you have read all the topics under Privacy Configuration 
to understand how enabling this feature could affect your application. 

 This feature is available only when the application is in Production or 
UAT mode.  

 Only the app_admin that was configured when the application was 
first downloaded can enable the privacy and security features. 

To enable the Privacy and Security feature: 

1) Select the Application Configuration tab. 

2) Select the Privacy & Security Feature link. 

3) Select the Enable checkbox. 

4) Click Update. 

Working with Privacy Configurations 

You can use the Privacy Configuration tab to: 

 configure a privacy policy and consent notice for the web application. 

 configure consent notices for mobile users and administrators 

 enable or disable features and modules that expose PI 

 validate your privacy configuration 

 provide consent for existing users 

 reset the privacy consent status 

 view consent status report 

Configuring Web Privacy Policy Settings 

From the Web Privacy Policy Settings page, you can create a privacy policy for your 
organization. You can choose to display the privacy policy as link in the footer of the application 
or require users to read the privacy policy and provide their consent . The privacy policy you set 
here is also used as the consent notice for the web application, and is displayed when users log 
in to the application for the first time. The application requires the default consent notices to be 
created in English. 

For more information on enabling the privacy policy or displaying consent notices, see topic 
Enabling or Disabling Privacy Feature settings.

To configure a privacy policy for the web application: 

1) Select the Privacy Configuration tab. 

2) Select the Web Privacy Policy Settings link.  
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3) Select how you want to enter your privacy policy. Choose HTML Text, Simple Text, or 
External Privacy Policy Web Page. 

4) If you selected HTML Text or Simple Text: 

a. From the Languages drop-down menu, select English. 

b. Enter and format the text. The character limit is 64000. 

Note: Work with your data security and legal teams to determine the 
wording of the privacy policy. 

c. Click the Validate and Preview button. 

d. Review and click the Apply button. 

5)  If you selected External Privacy Policy Web Page: 

a. From the Languages drop-down menu, select English. 

b. Enter external web link to your organizations web policy page. 

c. Click Save. 

6) Repeat steps 3 to 5 for each additional language. 

Mobile Consent Notice Configuration 

To configure the mobile consent notice: 

1) Select the Privacy Configuration tab. 

2) Select the Mobile Consent Notice Configuration link. 

3) From the Languages drop-down menu, select English. 

4) Enter and format the text. 

Note: Work with your data security and legal teams to determine the 
wording of the consent notice. 

5) Click the Validate and Preview  button. 

6) Review and click the Apply button. 

For more information on requiring consent from users accessing the mobile app, see topic
Enabling or Disabling Privacy Feature settings.

Application Administrator Consent Notice 

To create a consent notice for application administrators: 

1) Select the Privacy Configuration tab. 

2) Select the Application Administrator Consent Notice  link. 

3) Select how you want to enter your privacy policy, choose HTML Text, or Simple Text. 

4) From the Languages drop-down menu, select English. 

5) Enter and format the text. 

Note: Work with your data security and legal teams to determine the 
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wording of the privacy policy. 

6) Click the Validate and Preview button. 

7) Review and click the Apply button. 

Enabling or Disabling Privacy Features 

When the Privacy & Security feature is enabled, all features and modules that may expose a 
user's PI are disabled. As an administrator, you can choose to enable these features for all 
users.  

To enable privacy features: 

1) Select the Privacy Configuration tab. 

2) Select the Enable Privacy Settings Feature  link. 

3) Select the checkbox next to the features you want to enable. 

4) Click Save. 

Tip:  

Click the View History button to view details on all feature setting changes. You can download 
or print this information. 

Feature or Module  Name Description 

BI Data  Export Allow users to export data using BI Publisher. 

Cron Job/Scheduled 
reports 

Allow users to schedule cron jobs or reports. 

Data Import/Export Allow users to import or export data. 

Export Feature for the 
treegrid on listing page 

Allow users to export data from listing pages. The Export 
button on listing pages is enabled. 

Integration (API) Allow users to use integration APIs. 

MSP Data Export Allow users to export MSP data. 

Reports Allow users to generate reports. The Reports module is 
enabled. 

Allow end user to export 
Profile data in CSV 
format 

Allow users to export their profile data in CSV format from 
their My Profile page. 

Display My Profile page 
to all users 

Allow users to access their My Profile page even if they do 
not have the required navigation permission to view their 
profile.  

Editing of mandatory My 
Profile data 

Allow users to access and edit the required fields on their 
My Profile page. If this feature is disabled, users with the 
Create/Modify Resource permission can continue to edit 
their profile. 
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Display Privacy Policy Display the privacy policy as a link on the footer of the 
application. 

Require Resource 
Consent 

Require users to provide consent to the privacy policy 
before accessing the application. The consent notice will be 
displayed when users or administrators log in to the web 
application or the mobile application. To enable this feature, 
you must first configure the default web privacy policy, 
mobile consent notice, and the application administrator 
consent notices in English.  

When this feature is enabled, users must consent to the use 
of their PI before they can be assigned to an idea, proposal, 
or project. The consent status for all existing users is 
changed to Consent Pending. As an administrator, you must 
provide your consent before you can enable this feature. 

Validating Privacy Configuration 

To validate your privacy configuration: 

1) Select the Privacy Configuration tab. 

2) Select the Validate Privacy Configuration link. You can choose print or download the 
results as a PDF. 

Administering Privacy Configurations 

Providing Consent for Existing Users 

As an administrator, you can choose to provide consent on behalf of all users currently 
configured in the system. An email is sent to the users informing them that you have provided 
consent on their behalf. The Existing User Consent Setting link is disabled if all resources have 
provided their consent. 

To provide consent for existing users: 

1) Select the Privacy Configuration tab. 

2) Select the Existing User Consent Setting link. 

3) Select the Exclude Active Resource checkbox to allow active users to log in to the 
application and provide their consent. 

4) Select the I Agree checkbox and click Save.  

Note: If you have provided consent on behalf of other users, it is your 
responsibility to ensure the consent has been provided by the users 
through other means. 
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Resetting the Privacy Consent Status 

If you have modified the privacy policy, you can reset the consent status for all active users. 
Users are required to review the updated consent notice and provide their consent when they 
log in to the application. The consent status for all existing users is changed from Consent 
Provided to Consent Pending. You can also reset the mobile consent status. 

The Reset Privacy Consent Status link is disabled  if no user has provide their consent. 

To reset the privacy consent status: 

1) Select the Privacy Configuration tab. 

2) Select the Reset Privacy Consent Status link. 

3) Select the Reset User Mobile Consent Status checkbox, to reset the mobile consent 
status. 

4) Select the I Agree checkbox. 

5) Click Save. 

Viewing Consent Status Report 

The Consent Status report displays details of all consents provided by users. The report displays 
the following columns: resource name, consent state, consent provided by, consent provided for, 
and consent provided on. This report outputs in CSV format.  

1) Select the Privacy Configuration tab. 

2) Select the Consent Status Report  link. 

3) Select the filter parameter you want to use. 

4) Click Export. 

Resource and Security Admin 

In This Section 

Resource Administration ......................................................................................... 19 
Resource Configuration ........................................................................................... 33 
Resource Admin Reports ........................................................................................ 46 
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Resource Administration 
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Creating Application Administrators 

Application Administrators perform various administrative functions to ensure that the system 
runs smoothly. They set up and manage the application and assign access rights or permissions 
for resources to access the system. 

Application Administrators are associated with initiatives and have access to all projects within 
their initiative, including confidential project. They can also access all modules within 
EnterpriseTrack.  

Note: You cannot assign administrators to any projects. 

To create an application administrator: 

1) Click the Resource & Security Admin tab. 

2) Select the Application Administrators link. The Application Administrator List page is 
displayed.  

3) Click the Add Application Administrator button. 

4) Enter a Login ID.  

5) Enter the first name, last name and email address. 

Note: Passwords in the EnterpriseTrack system have to be a minimum 
of 8 characters and must contain both alpha and numeric values and at 
least one special character like *, $, or an underscore. 

6) Select a status. Specify when the selected status should become effective.   

7) Select the type of labor rate. 

8) If your system is configured with multiple initiatives, select all initiatives that this application 
administrator is associated with from the Associated Initiatives field.  

9) Enter any additional information under the Resource Details, Contact Info, Organizations, 
Preferences, and the Additional Resource Details sections.  

10) If the Privacy & Security and the Require Resource Consent features are enabled, review 
the consent notice and provide consent on behalf of this administrator.  

11) Click Add Application Administrator. 
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Unlocking a Resource 

You can use the Resource Locks page to view and unlock all resources that are currently locked 
out. 

To unlock a resource: 

1) Click the Resource & Security Admin tab. 

2) Select Login Locks. 

3) In the Action column for the appropriate resource, click Unlock. 

Assigning Permissions to System Access Profiles and Roles 

Resources within EnterpriseTrack are assigned permissions based on their resource access 
profiles and the roles that they are allowed to perform. Before assigning permissions, it is 
important to understand how resource access profiles and roles are defined within the system. 

System Access Profiles 

Each resource in the EnterpriseTrack system must be assigned a system access profile. The 
system access profile determines a resource's global permissions. A resource can have only 
one system access profile. 

Roles 

Each resource in the EnterpriseTrack system can be assigned multiple roles. The roles 
determine the project specific permissions for any given resource in the system. Only resources 
that have at least one role assigned to them are available as potential team members of 
projects. 

Editing Permissions 

To begin managing permissions based on system access profiles and roles: 

1) Click the Resource & Security Admin tab. 

2) Click the Edit Permissions link. 

3) In an installation with multiple initiatives on one system, you must first select the initiative that 
you want to modify. 

4) Select the module you wish to modify. 

5) Click the Edit Permissions button. 
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6) You will see a break-down of the various actions that can be performed within the selected 
module and a grid displaying the various system access profiles and roles that are available 
in the system. Use the check boxes to modify the permissions. 

7) Click Save. 

Notes:

 When an action cannot be performed based upon a system access 
profile or role, the system will not display a check box. An n/a sign 
will be displayed instead.  

 All actions with the Knowledge Base have to be based on system 
access profiles, not roles, so there will be no check boxes in the 
Roles section of the page. 
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Editing Administration Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to the Administration module. The list below describes the permissions you 
can select. 

 Configure Application

Access the Administration module to configure EnterpriseTrack. This permission is typically 
given to administrators. 
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 Manage Messages

Manage the Messages module. From the Messages module users can send system-wide 
messages or send messages to a select group of users. 

 Create/Modify Resources

Add, edit and delete resources. The Manage Resources link is enabled and displayed only if 
users have this permission. 

 Manage Languages

Modify the language catalog. 

 Manage Survey Administration

Manage and administer the Survey module. 

 Manage Survey Instances

Create and edit surveys. 

 Save Layout For Access Profile

Manage and save the layout (Home Page, Project Landing page, and Project Listing 
Columns) for each access profile. 

 Share Saved Search

Select to allow users to share saved searches. 

 Execute APIs

Execute integrations APIs. Typically this permission is given only to users who are 
integrating EnterpriseTrack with other programs or application. 

 Execute APIs as Proxy

Execute integration APIs on behalf of others. 

 Manage Reference Calendars

Create, edit, and delete Reference Calendars. 

 Manage Labor Expense Type Mapping

Manage the Labor Expense Types. The Manage Labor Expense Types link is displayed only 
if users have this permission. 

 Modify Evaluation Weights

Configure evaluation weights for proposals and ideas. 

Editing Dashboard Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to the Dashboard module. Click to select the dashboard components you 
want a particular role or access profile to be able to access. Only the dashboard components 
you select here are editable through the Dashboard module. 

Editing Finance Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to the Finance module. The list below describes the permissions you can 
select. 



Resource and Security Admin

23

 Manage Global Financial Settings

Modify all setting under the Finance Management section. This permission is typically given 
to administrators. 

 Manage all Finance Templates and Finance Approval Templates

Modify all finance templates and finance approval templates. The Manage Finance Template 
and the Mange Finance Approval Template are displayed only if this permission is enabled. 

 Manage Finance Templates and Finance Approval Templates for resource Initiative

Manage finance templates and finance approval templates for resource initiative. 

 Update Inputs for Finance Fields (NPV, IRR etc)

Update the finance fields within a project. This permission is typically given to a role, for 
example Project Finance Administrator. 

 Update Project Lock Month - Single View

Update the lock month associated with a project. This permission is typically given to a role, 
for example Project Finance Administrator. This permission is applicable only for projects 
using a finance template with the Data Entry Mode set to Single View (Basic Only). 

 Update Project Lock Month - Plan

Update the project lock month associated with the Plan view. This permission is typically 
given to a role, for example Project Finance Administrator. This permission is applicable only 
for projects using a finance template with the Data Entry Mode set to Double View (Plan and 
Actual). 

 Update Project Lock Month - Actual

Update the project lock month associated with the Actual view. This permission is typically 
given to a role, for example Project Finance Administrator. This permission is applicable only 
for projects using a finance template with the Data Entry Mode set to Double View (Plan and 
Actual). 

 Update the Use Global Lock Month - Single View

Update or delete the global finance lock month. This permission is typically given to a role, 
for example Project Finance Administrator. This permission is applicable only for projects 
using a finance template with the Data Entry Mode set to Single View (Basic Only). 

 Update the Use Global Lock Month - Plan

Update or delete the global finance lock month associated with the Plan view. This 
permission is typically given to a role, for example Project Finance Administrator. This 
permission is applicable only for projects using a finance template with the Data Entry Mode 
set to Double View (Plan and Actual). 

 Update the Use Global Lock Month - Actual

Update or delete the global finance lock month associated with the Actual view. This 
permission is typically given to a role, for example Project Finance Administrator. This 
permission is applicable only for projects using a finance template with the Data Entry Mode 
set to Double View (Plan and Actual). 

 Project Finance Administrator

Allow a particular role to be the designated project Finance Administrator. It allows them to 
update lock months at the project level. 

 Update Finance Tracking Start Date
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Update the finance tracking start date associated with a project. 

 Update Project's Finance and Approval Templates

Update the project finance template and the project finance approval template. 

 Update Finance Snapshot Data

Update and delete project finance snapshot data. The Snapshot button on the Detailed 
Finances tab is visible only if users have this permission. 

 Update Finance Data - Single

Update finance data for projects. This permission is applicable only for projects using a 
finance template with the Data Entry Mode set to Single View (Basic Only). 

 Update Finance Data - Plan

Update the finance (Plan view) data for projects. This permission is applicable only for 
projects using a finance template with the Data Entry Mode set to Double View (Plan and 
Actual). 

 Update  Finance Data - Actual

Update the finance (Actual view) data for projects. This permission is applicable only for 
projects using a finance template with the Data Entry Mode set to Double View (Plan and 
Actual). 

 Update Project Currency

Update the project currency. 

 Manage Currencies and Conversion Rates

Manage the currencies and conversion rates. The Manage Currencies and Manage 
Conversion Rates links are displayed in the Administration module when this permission is 
enabled. 

 Manage Group Finance Validation

Validate finances across all projects. The Finance Validation button is displayed on the 
Project Listing page only if the permission is enabled. 

 Manage Project Finance Setting Excel Import/Export

Manage the import/export of project finance setting using Microsoft Excel. 

Editing Ideas Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to the Ideas module. The list below describes the permissions you can 
select. 

 Modify Idea

Modify ideas. 

 View Confidential Submitter Details

View confidential submitter details. 

 Accept/Reject Idea

Accept or reject ideas. 

 Delete Idea
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Delete ideas. 

 Route Idea

Route an idea for approval. 

 Own Idea

Own ideas. 

Editing Proposal Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to Projects. The list below describes the permissions you can select. 

 Modify Details before Initial Team Creation

Allow editing the Details section of the proposal before the initial team is created. 

 Modify Details after Initial Team Creation

Allow editing the Details section of the proposal after the initial team is created. 

 Modify Confidentiality before Initial Team Creation

Allow editing the Confidentiality section of the proposal before the initial team is created. 

 Modify Confidentiality after Initial Team Creation

Allow editing the Confidentiality section of the proposal after the initial team is created. 

 Assign Proposal Signoff Team Members

Allow users to assign team members who can signoff on proposals. 

 Submit Proposal for Team Signoffs

Allow users to submit proposal for team signoffs. 

 Hold/Un-Hold Proposal

Allow proposals to be put on hold and to remove hold on proposals. 

 Edit Sign-offs on behalf of Other Team Members

Allow signoffs to be modified on behalf of other team members. 

 Approve/Reject/Reopen Proposal

Allows proposals to be approved, rejected, and reopened. 

 Accept Proposal and Create Project

Creates a project when the proposal gets accepted. 

Editing Project Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to the Projects. The list below describes the permissions you can select. 

 Create Confidential Documents

Create confidential documents. 
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 Create Quick Projects

Create projects without starting from a proposal. 

 Manage Project Notifications

Edit email notification settings at the project level using the Project Settings page. 

 Modify Project Basics

Modify project basics. 

 Modify Project Manager

Modify the Project Manager associate with a Project. 

 Modify Confidentiality

Modify project confidentiality settings. 

 Modify Dates

Modify project dates. 

 Modify Other Resource Tollgate

Modify tollgates associated with other resources. 

 Modify Baseline Dates and Efforts Activities

Modify an activity's baseline date and efforts. 

 Create Documents

Create project documents. 

 Modify Documents

Modify project documents. 

 Send Email to Project Members

Email project team members. 

 Create Issues

Create project issues. 

 Modify Issues

Modify project issues. 

 Create Metrics

Create project metrics. 

 Modify Metrics

Modify project metrics. 

 Create Notes

Create project notes. 

 Create Confidential Notes

Create confidential notes. 

 Create Team Members

Add project team members. 

 Modify Team Members

Modify project team members. 

 Set Project On-Hold/Off-Hold
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Set a project on-hold or off-hold. 

 Close Projects

Close projects. 

 Complete Projects

Mark projects as complete. 

 Reopen Projects

Reopen closed projects. 

 Request Approval for an Activity

Request approval for an activity. 

 Approve Activity for Others

Approve activity for others. 

 Create/Modify/Delete Activity at Top-Level for Roadmap

Create, modify and delete top-level activities for roadmaps. 

 Create/Modify/Delete Activity Other Level for Roadmap

Create, modify and delete activities for roadmaps. 

 Create/Modify/Delete Activity at the Top-Level for Non Roadmap

Create, modify and delete top-level activities for non-WBS roadmaps. 

 Create/Modify/Delete Activity at Other Level for Non Roadmap

Create, modify and delete activities for non-WBS roadmaps. 

 Reopen Top Level Activity

Reopen a top level activity. 

 Advance Top Level Activity

Advance top level activity. 

 Copy Projects

Copy projects. 

 Delete Projects

Delete projects. 

 Change Roadmap

Change a project's roadmap. 

 Cancel/Reactivate Project

Cancel or reactivate projects. 

 Export Microsoft Project Plan

Export a Microsoft Project Plan. 

 Release Lock or Import MSP by Others

Release lock and import from MS Project. 

 Manage Computation Mode

Manage the computational Mode. 

 View Team Member Rate 

View team member rate. 
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 Modify Team Member Rate

Modify team member rate. 

 Override Team Member Rate

Override a team member's rate. 

 Manage Labor Expense Type

Manage Labor Expense Types. 

 Create Risks

Create project risks. 

 Modify Risks

Modify project risks. 

Editing Programs Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to programs. The list below describes the permissions you can select. 

 Create Program

Create programs. 

 Modify Program Details

Modify program details. 

 Modify Program Manager

Change the program manager associated with a program. 

 Assign Projects to Programs

Add projects to a program. When this permission is enabled, the Associate Projects section 
is displayed on the Create Program and Edit Program pages. 

 Assign Proposals to Programs

Add proposals to a program. When this permission is enabled, the Associate Proposals 
section is displayed when creating or editing proposals. 

 Can be Assigned as Program Manager

Assign users with the selected access profile to the role of a program manager. 

 Delete Program

Delete programs. 

 View Program Budget Section

View the Program Budget section when creating, viewing, or editing programs. This 
permission only affects seeing the Program Budget section, it does not affect the finances 
that are shown in the associated Projects or Proposals Grid, nor does it affect the separate 
Program Finance Page. If a section is hidden all custom fields associated with that section 
are also hidden. 

 View Program Organization Section

View the Program Organization section when creating, viewing, or editing programs. If a 
section is hidden, all custom fields associated with that section are also hidden. 

 View Program Statements and Notes Section
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View the Program Statements and Notes section when creating, viewing, or editing 
programs. If a section is hidden, all custom fields associated with that section are also 
hidden. 

 View Program Dates Section

View the Program Dates section when creating, viewing, or editing programs. If a section is 
hidden, all custom fields associated with that section are also hidden. 

 Edit Program Risks

Modify program risks. 

 Edit Program Issues

Modify program issues. 

 Edit Program Activities

Modify Program activities. 

 Resource can be a Program Issue Owner

Allows user to be a program issue owner. 

 Resource can be a Program Risks Owner

Allows user to be a program risk owner. 

 Resource can be a Program Activity Owner

Allows user to be program activity owner. 

 View Program Evaluation Section

View the Program Evaluation section when creating, viewing, or editing Programs. 

 Can Edit Program Evaluation Criteria

Allow user to modify the evaluation impact values for Programs. 

 Can Change Program Evaluation Matrix

Allow user to change the program evaluation matrix. You can change the Program 
evaluation matrix only when there are more than one active program evaluation matrices. 

 Can Edit Program Evaluation Weights

Allow user to modify the Program evaluation weights on an individual program. 

 Create Documents

Allow user to create documents for Programs. 

 Modify Documents

Allow user to modify Program documents. 

 Modify Program Notifications

Allow users to modify and disable program notifications for individual programs. 

Editing Alignment (Strategy) Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to Alignment (Strategy). The list below describes the permissions you can 
select. 

 View Organization Alignment (#)

 View Non-Organization Alignment
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 Add, Edit, and Delete Alignment (#) Nodes in resource organization

 Add, Edit, and Delete Alignment (#) Nodes in organizations other than resource 
organization

 Add, Edit, and Delete Nodes in Non-Organization Alignment (#)

 Specify a resource as the owner of a Alignment (#)

 Align Alignment (#) to an Idea

 Align Alignment (#) to a Proposal before Initial Team Creation

 Align Alignment (#) to a Proposal after Initial Team Creation

 Align Alignment (#) to a Project

 Trigger  Rollup Manually for Alignment (#)

 Resource can be Measure Owner of Alignment (#)

 View Idea Alignment to Alignment (#)

 View Proposal Alignment unassigned to Alignment (#)

 View Proposal Alignment Postassigned to Alignment (#)

 View Program Alignment to Alignment (#)

Select to make the Alignment section for a particular alignment visible in the Program Basic 
page in view and edit modes. This permission also controls the visibility of the Program tab in 
the Alignment Details section. 

 Align Alignment (#)  to a Program

Select to associate a program to an alignment from the Program Basic page in edit mode. 
This permission also controls the association of a program to the alignment node using the 
Programs tab in the Alignments Details section. 

Editing Navigation Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to the Navigation module. You can enable the following modules:  

 My Work 

 My Preferences 

 Ideas 

 Programs 

 Knowledge Base 

 Resources 

 Timesheets 

 Reports 

 Proposals 

 Surveys 

 Project Dates 

 Project Documents 

 Project Finances 

 Project Import/Export 

 My Messages 



Resource and Security Admin

31

 Program Risks, Issues, Documents, Activities, Timeline, and Settings. 

Within each project, you can also set permissions to view the following: project dates, project 
documents, project finances, project import/export, project issues, project metrics, project notes, 
project reports, project settings, project status report, project team, linked project, WBS work 
items, and non-WBS work items. 

Editing Reports Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to the Reports module. Click to select the reports you want a particular role 
or access profile to be able to access. Only the reports you select here are editable through the 
Reports module. 

Editing Status Report Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to status reports. The list below describes the permissions you can select. 

 Create/Edit Status Reports

Create and edit status reports. 

 Approve/Reject Status Report

Approve or reject status reports that were submitted. 

 Edit Approved Status Reports

Make changes to approved status reports. 

 Delete Status Report

Delete status reports. 

Editing Resource Permissions 

You can use the Edit Permissions page to edit role-based and access profile-based 
permissions related to resources. The list below describes the permissions you can select. 

 View Resource Assignments

View all resource assignments. 

 View Resource Utilization Chart

View the resource utilization chart for all resources. 

 Create and Edit Timesheet

Create and edit timesheets. 

 Enter Non-Project Time

Enter non-project time in timesheets. 

 Enter Non-Working Time

Enter non-working time in timesheets. 

 Enter Project Level Time

Enter project level time in timesheets. 

 Enter Activity Level Time
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Enter time at the activity level in timesheets. 

 Delete Timesheet

Delete their timesheets if the timesheet status is Open, Submitted, or Rejected during the 
Timesheet Open Period. 

 View Other Resource Timesheets

View all resource timesheets. 

 Re-open Approved Timesheet

Edit all approved timesheets. 

 Delete Other Resource Timesheet

Delete timesheets submitted by other resources, if the timesheet status is Open, Submitted, 
or Rejected during the Timesheet Open Period. 

 Allow Resource Manager to Approve (or Reject) Project Line Items

Allow the Resource Manager of the timesheet submitter to also approve/reject project line 
items. 

 Manage Timesheet Periods

Set a timesheet close period, reopen timesheets for correction, and run timesheet status 
reports. 

 Approve Resource Requests for all Roles

Approve project resource requests for all roles. 

 Approve Resource Requests for  Allowed Roles

Approve resource requests for allowed roles. You can only approve requests for roles that 
you are assigned to. 

 Approve Resource Requests for other Approvers

Approve resource requests for approvers. 

 View Resource Utilization Tab, View Resource-Gantt Tab, View Resource-Heatmap 
Tab, View Resource-Assignments Tab, View Resource-Rate Tab, View 
Resource-Expertise Tab, View Resource-Certifications Tab

View the Resource Utilization, Resource-Gantt, Resource-Heatmap, Resource-Assignments, 
Resource-Rate, Resource Expertise, and the Resource-Certification tabs on the Resource 
Listing page. 

 Edit All Resource Certifications

Allow resource to create and edit certifications.

 Edit All Resource Assets

Allow resource to create and edit assets.

 Allow user to view/Search login ID

View and search login IDs. 

 View All Resource Calendars

View all resource calendars. 

 Edit All Resource Calendars

Edit all resource calendars. 

 Edit My Resource Calendar
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Edit only their calendar. 

 Modify Resource Confidentiality

Modify confidentiality for resources. 

Resource Configuration 
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Managing Resources 

A resource is any person or equipment that you can track and assign to project activities. 
Resources perform roles within projects. Each resource is associated with an Access Profile and 
at least one role. 

From the Resources link, you can add, edit, and delete resources. You can also manage their 
profile, area of expertise, certification, assets, calendar, rate, and password. 

Note: As all PI data is editable and does not play a part in database-key 
integrity, you can manually encode or tokenize any PI field without 
sacrificing data integrity. 
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Adding Resources 

You can use the Add New Resource page to add resources to your system. You must have the 
appropriate permissions to add resources. Once you have created a new resource, you can use 
the Edit option to update a resource profile to include certifications and assets. 

Note: You must complete all mandatory fields highlighted in red. 

To create a new resource: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Select Create > Resource. The Add New Resource screen is displayed. 

Entering Resource Details 

1) Choose the type of resource: Equipment (if enabled) or Person. The information fields 
change depending on the resource type you selected. 

2) If you selected resource type Person, enter a Login ID, First Name, and Last Name. If you 
selected resource type Equipment, enter a Login ID, the Make, Resource Name, Owner 
First Name and Owner Last Name. 

3) Select an Access Profile. All resources in the system must have an Access Profile. 

4) Select a status. The default status is Active.  

5) Specify when this resource status should become effective. 

6) Enter the user authentication mode. This field displays only if the default user authentication 
mode was set to LDAP or SSO. 

7) Enter a password. This field appears only if the user authentication mode is set to User 
Password. 

8) Enter an Email address. 

Selecting an Organization 

1) Select a division. The other fields are populated based on the value you select here. 

2) Enter a business unit and business subunit. 

Selecting Time Reporting, Calendar, and Rates 

1) Select a calendar. The default calendar is the Standard Calendar.  

Note: You must associate a resource with a calendar. The resource 
calendar is used to calculate resource utilizations. 

2) Select the type of labor rate. If you select Use Role Rate, then the labor rate for this 
resource is based on the rate associated with their role. If you select Use Resource Rate, 
enter the standard, overtime, or setup labor rates. 

Selecting Initiatives and Roles 

1) From the Associated Initiatives selection box, select all initiatives associated with this 
resource.  
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2) From the Roles selection box, select the roles this resource can perform within each 
initiative. You can select multiple roles for a user. In single initiative systems, you must select 
at least one role. 

3) From the Access selection box, select the access this resource has. This field is displayed 
only if the selected initiative has user based confidentiality. 

Providing Consent 

This section is displayed only if your administrator has enabled the Privacy & Security and the 
Require Resource Consent features. Review the consent notice and provide initial consent on 
behalf of this resource. An email is sent informing them that you have provided initial consent. 
Users will be required to review the consent notice and provide their consent when they first log 
in to the application. If you are adding an equipment or configuring an inactive resource, no 
additional consent notice is displayed as they cannot log in to the application. 

Adding Additional Information, Selecting Preferences and Areas of Expertise 

1) Click the Additional Information tab. 

2) Enter any additional information under the Contact Information and Additional Resource 
Details sections.  

3) Select default preferences for this resource. 

 Date Format: Select how you want dates to be displayed. 

 Date Separator: Select how you want the date, month, and year to be separated. 

 Time Format: Select how you want the time to be displayed. 

 Language: Select your language. All system-generated emails are also displayed in the 
language you select here. 

 Use Browser Language: Select this check box to make the language displayed by 
EnterpriseTrack match your browser’s language setting. When the Use Browser 
Language check box is not selected, EnterpriseTrack is displayed in the language 
selected in the Language drop-down list. 

 Include Archived Pull Downs in Filter: Select this check box if you want to view 
archived pull-down values in filters. 

 Include Invalid Pull Downs in Filter: Select this check box if you want to view invalid 
pull-down values in filters. 

4) From the list of Available Areas box, select the areas of expertise. 

a. To add an area of expertise to the list, click the Add link next the Selected Areas label. 

b. Enter a name and click OK. 

Adding Resource Custom Fields 

1) Click the Resource Custom Fields tab. 

2) Enter values for any custom fields that are configured. If your administrator has configured a 
tool tip, you can mouse over the Information icon to view the help text. 

3) Click Add Resource. 
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Editing Resources 

You can edit a resource profile to: 

 Update personal information. 

 Manage certifications and assets. 

 Update area of expertise. 

 Change passwords. The Change Password button is displayed only if the authentication 
mode is User Password. 

To edit a resource profile: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource profile you want to edit and select Actions > Edit. You can choose to 
edit the Details, Area of Expertise, Certification, Assets, Calendar, and Rates. 

3) From the Edit Resource page, make all the necessary changes. 

4) Click Update. 

Managing Certifications 

From the Resource List page, you can view, add, edit, and delete certifications associated with a 
resource profile. Adding certification information to a resource's profile is one way to ensure that 
a resource's skills are appropriately matched with a project's requirements. 

Viewing Certifications 

To view certifications: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource.  

3) From the Actions menu, choose Select. 

4) Click the Certifications tab. 

Adding Certifications 

To add certifications: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource. 

3) From the Actions menu, select Edit > Certifications.

4) Click the Add Cert button. The Add New Certifications page is displayed.  

5) Enter all the relevant information. 

6) Click Add Cert. 



Resource and Security Admin

37

Editing Certifications 

To edit the details of an existing certificate: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource.  

3) From the Actions menu, select Edit > Certifications.

4) Click the Certification ID link to select the certification you want to edit. The Edit 
Certification Info page is displayed. 

5) Make the necessary changes and click Update. 

Deleting Certifications 

To delete an existing certification: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource. 

3) From the Actions menu, select Edit > Certifications.

4) Click the Certification ID link to select the certification. 

5) Click Delete. 

6) Click OK to confirm the deletion. 

Managing Assets 

You can use the Resource Listing page to view, add, edit, or delete assets associated with a 
resource. An asset may include items like laptop, pager, cell phone etc. 

Viewing Assets 

To view assets associated with a resource: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource.  

3) From the Actions menu, choose Select. 

4) Click the Assets tab. 

Adding Assets 

To add assets: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource.  

3) From the Actions menu, select Edit > Assets.

4) Click the Add Asset button. The Add New Asset page is displayed.  

5) Enter a serial number for the asset. 
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6) Select the type of asset.  

7) Enter a description for this asset. 

8) Click Add Asset. 

Editing Assets 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource. 

3) From the Actions menu, select Edit > Assets.

4) Click on the Asset ID link to select the asset you want to edit. The Edit Asset Info page is 
displayed. 

5) Make the necessary changes and click Update. 

Deleting Assets 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource.  

3) From the Actions menu, select Edit > Assets.

4) Click on the Asset ID link to select the asset you want to delete. The Edit Asset Info page is 
displayed. 

5) Click Delete to remove the asset.  

6) Select OK to confirm the deletion. 

Changing Passwords 

To change a resource password: 

1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource.  

3) From the Actions menu, select Edit > Details. The Edit Resource Info page is displayed. 

4) Click the Change Password button. 

5) Enter a new password. 

6) Enter the same password in the Confirm Password field. 

7) Click Change. 

Note: A password must be at least 8 characters long and contain at 
least one character that is not alphanumeric, an underscore or 
white-space. E.g. *, %, $ etc. 

Deleting Resources 

To delete a resource: 
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1) From the Top Navigation bar, select Go To > Resources > Listing. The Resource Listing
screen is displayed. 

2) Locate the resource profile you want to delete. You can use the Quick Filter to help you find 
a resource. 

3) From the Actions column, select Delete. 

4)  Click OK to confirm the deletion. 

Notes: 

 The system may require you to delete a resource's assets and 
certifications before deleting a resource.  

 You cannot delete a resource that is currently assigned to a project. 
You have to reassign the project to another resource. 

Reset User Consent Status 

You can reset the consent status of users who have previously withdrawn their consent. This 
option is displayed only if the Privacy & Security and the Require Resource User Consent 
features are enabled. 

To reset the consent status of a user: 

1) From the Top Navigation bar, select Go To > Resources > Listing. 

2) Select the resource and click > Reset Consent Status. 

Using Search, Advanced Search, and Saved Search 

EnterpriseTrack allows you to filter your resource list in multiple ways. You can search for a 
specific name, view all last names beginning with a particular letter or filter by other criteria using 
the sophisticated filtering engine. 

Searching for a Resource 

To search for a specific name, enter the appropriate letter in the Last Name Starts with field and 

click the Go  icon. You will see a list of resources matching the search criteria you entered. 

Modifying Advanced Search 

To modify the advanced search setting: 

1) Click the Advanced Search link. 

2) On the Advanced Search page, enter the appropriate values, check the appropriate boxes or 
choose from the pull-down menus. 

3) You can view the current search criteria by clicking the Show Current Search Criteria field. 

4) Enter your selection criteria in the relevant fields. In most systems, you will be able to filter by 
Initiative, title, location or work address and organizational unit. 

5) Click the Search button to apply the search and return to the list of projects. 
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Note: When you choose to include the documents field in the keyword 
definition, the system will search through the text of the uploaded project 
documents. 

Managing Saved Search Criteria 

To save a new search: 

1) From the Manage pull-down menu select Create. 

2) Enter a new name in the Filter name field and enter a description.  

3) Select if you want to make this the default search. 

4) Select if you want to share this search with other users.  

5) Specify the appropriate values, check the appropriate boxes or choose from the pull-down 
menus. 

6) Click the Save Search button. 

To edit an existing search: 

1) From the Saved Search: View menu select the search you want to edit. 

2) From the Manage pull-down menu select Edit. 

3) Select the search you want to modify from the Load a Saved Search pull-down menu. 

4) Make the required changes in the various fields used to specify the search criteria. 

5) Click the Save Search button. 

To delete an existing search: 

1) From the Saved Search: View menu select the search you want to delete. 

2) From the Manage pull-down menu select Edit. 

3) Click the Delete Search button. 

Note: Only user-defined searches can be deleted. 

To reset filters to default values: 

From the Advanced search page, click the Reset Filter button. 

Managing Resource System Access Profiles 

Resource access profiles allow you to define global (non-project specific) permissions within the 
system. All resources assigned to a resource system access profile have all the global 
permissions associated with their selected access profile. You can use the Manage Resource 
Access Profile page to create and manage all access profiles defined in your system. You can 
also define the default project listing columns, and the project landing page that will display for 
each resource access profile. All resources in the system must have an access profile and each 
resource can have only one access profile. 
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Creating Resource System Access Profiles 

To create a resource system access profile: 

1) Select the Resource & Security Admin tab. 

2) Select the Resource System Access Profile link. The Resource Access Profiles List page 
displays. 

3) Click Create a New Resource Access Profile. 

4) Enter a name for this access profile. 

5) Choose a homepage for this profile. All resources with this system access profile will be 
taken to this page when they log in. 

6) Specify a project landing page. When a resource accesses a particular project, they will be 
taken to the page specified here. 

7) Click Add Access Profile. 

Editing Resource System Access Profiles 

To edit a resource access profile: 

1) Click the Resource & Security Admin tab. 

2) Select the Resource System Access Profiles link. The Resource Access Profiles List page 
displays all existing access profiles. 

3) Click on the name of the resource profile you want to edit. 

4) Modify the name of this profile. 

5) Click Update. 

Configure Default Project Listing Columns 

You can use the Resource Access Profiles List page to customize columns on the Project Listing 
page. 

To configure default project listing columns: 

1) Click the Resource & Security Admin tab. 

2) Select the Resource System Access Profiles link. The Resource Access Profiles List page 
displays a list of all existing system access profiles. 

3) Click the Configure Default Project Listing Columns button. 
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4) Use the > and < buttons to add and remove columns. Use the Up and Down buttons to 
move the selected columns to the left or right. The topmost column is displayed on the 
farthest left of the screen. 

5) Click Update. 

Specifying Home Page by System Access Profile 

To specify the home page by resource access profile: 

1) Click the Resource & Security Admin tab. 

2) Click the Resource System Access Profiles link. The Resource Access Profiles List page 
displays all existing system access profiles. 

3) Select an access profile by clicking on its name. 

4) Select a home page from the pull-down menu. All resources with this access profile will be 
taken to this page when they log in. 

5) Specify a project landing page. When a resource accesses a particular project, they will be 
taken to the page specified here. 

6) Click Update. 

Note: For more information on removing certain menu items from the 
Left Navigation bar for users with specific access profiles and for specific 
roles, see topic Assigning Permissions to System Access Profiles 
and Roles (on page 20). 

Managing Resource Roles 

Roles represent job titles or skills needed to execute project tasks. Manager, Finance 
Representative, Engineer, Architect, IT Manager, Network Administrator are all examples of 
possible roles. You will see a standard set of roles that are applicable to your organization 
already defined for you. You can create as many roles as you need. You can also assign 
resource to one or more roles. Roles also determine the project specific permissions for each 
resource in the system. Only resources with at least one role assigned to them are available as 
potential team members of projects. 

You can use the Resource Roles link, to add, edit, or delete resource roles. You can also edit 
labor rates associated with a role and view the rate change history.  

In This Section 

Creating Resource Roles ........................................................................................ 43 
Editing Resource Roles ........................................................................................... 43 
Editing Labor Rates for Roles .................................................................................. 44 
Viewing Rate Change History .................................................................................. 44 
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Creating Resource Roles 

To create a resource role: 

1) Click the Resource & Security Admin tab. 

2) Click the Resource Roles link. The Team Composition Settings page displays all the 
existing resource roles. 

3) Click Add a New Role. 

4) Select an initiative for this role 

5) Enter a name for this role. 

6) Enter the Sort Order ID. This defines the order in which it displays on listing pages. 

7) Select the type of proposal sign off you require for this role (Context-Sensitive, Signoff Not 
Required, Signoff Required, and Signoff Optional). 

If you selected the Context-Sensitive option, enter the conditions when signoff is required. 
The Context-Sensitive option displays only if the role is part of the initial project team. 

8) Enter the standard labor, overtime labor, and setup labor rates associated with this role. 

9) Enter the number of hours per week this role will spend of different project categories. For 
example: Project Management, Team Meetings, etc. 

10) Click Create. 

Note: In Reconfigure mode, you can change the number of resources 
assigned to a role only if no records were created. If records were 
created, you can only increase the number resources assigned to the 
role. 

Editing Resource Roles 

To edit a resource role: 

1) Click the Resource & Security Admin tab. 

2) Select the Resource Roles link. The Team Composition page displays all the existing 
resource roles. 

3) Click [Edit] next to the name of the resource role you want to edit. The Edit Role page 
displays. 

4) Edit the resource role. 

a. Modify the name for this role. 

b. Change the Sort Order ID. This defines the order in which it displays on listing pages. 

c. Select if you want this role to be part of the initial proposal team. 

d. Select if this role is required for the entire project duration. 

e. Select the type of proposal sign off you require for this role (Context-Sensitive, Signoff 
Not Required, Signoff Required, and Signoff Optional). 

If you select the Context-Sensitive option, enter the conditions when signoff is required. 
The Context Sensitive option displays only if the role is part of the initial proposal team. 

f. Modify the number of hours per week this role will spend of different project categories. 
For example: Project Management, Team Meetings, etc. 
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5) Click Update. 

Note:  In Reconfigure mode, you can change the number of resources 
assigned to a role only if no records were created. If records were 
created, you can only increase the number resources assigned to a role. 

Editing Labor Rates for Roles 

To edit labor rates for all resources associated with a role: 

1) Click the Resource & Security Admin tab. 

2) Select the Resource Roles link. The Team Composition Settings page displays all the 
existing resource roles. 

3) Select a role and click the [Edit Rate] link next it. 

4) Edit the current Standard, Overtime, and Setup rates, or click [Add Row] to add a new row 
to the rate table. 

5) Click the Calendar icon and select the effective start date. 

6) Click Update. 

Viewing Rate Change History 

To view all the labor rate changes associated with a role: 

1) Click the Resource & Security Admin tab. 

2) Click Resource Roles. The Team Composition Settings page is displayed. 

3) Select a role and click the [Edit Rate] link next it. 

4) Click the [View rate change history] link. 

Managing Resource Status 

Use the Resource Status screen to create and manage multiple resource statuses. For example, 
you can create a status called Inactive Transferred, for resources that no longer work for your 
organization, or Resource Active for resources that are currently employed.  

Note: Once you create a status, you cannot delete it. You can only 
change the status to Inactive, or Archived. 

To add a new resource status: 

1) Click the Resource & Security Admin tab. 

2) Click the Resource Status link. The Resource Status List screen is displayed. 

3) Click the Create a New Resource Status button. 

4) Enter a name for this status. 

5) Click Create. 

To manage resource statuses: 

1) Click the Resource & Security Admin tab. 
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2) Click the Resource Status link. The Resource Status List screen is displayed. 

3) Select a resource status from the list. 

4) Change the status to Valid, Invalid, or Archived. 

5) Click Update. 

Managing Resource Rate Default Rule 

You can specify the default resource or role rate that the system displays when creating new 
resources or roles.  

To set the resource or role rate default rule: 

1) Click the Resource & Security Admin tab. 

2) Click the Resource or Role Rate Default Rule link. 

3) Select Resource labor rate or Role labor rate. 

4) Click Update. 

Setting TBD Capacity in Resource Modules 

Use the Include TBD Capacity in Resource Modules link to select if you want to include or 
exclude TBD (To Be Decided) resource when calculating role capacity. If set to Yes, then TBD 
capacity is included when calculating capacity. If set to NO, then TBD capacity is not included 
when calculating capacity, only the demand is included. 

To set TBD capacity: 

1) Select the Resource & Security Admin tab. 

2) Click the Include TBD Capacity in Resource Modules link. 

3) From the Value pull-down menu, choose Yes or No. 

4) Click Update. 

Setting Default Percentage Utilization 

Use the Set Default Percentage Utilization link to select the default resource/role percentage 
utilization for each initiative configured in your system. The default value you set here is used to 
pre-fill the percentage utilization for all resource or role allocations. 

To set the default percentage utilization: 

1) Select the Resource and Security Admin tab. 

2) Click the Default Percentage Utilization link. 

3) Enter a value for each initiative configured in your system. 

4) Click Update. 
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Resource Admin Reports 

In This Section 
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Usage Statistics Report 

Use the Usage Statistics Report to view account usage. This report displays the following 
information: 

 The number of initiatives loaded. 

 A count of resources that accessed the system in the past 7 to 180 days. 

 A count of projects updated in the past 7 to 180 days by initiative. 

 The number of Ideas created. 

 A count of proposals by initiative and status. 

 Project Information 

 A count of projects by initiative. 

 A count of projects by initiative and status. 

 A count of project components  

 Resource Information 

 The total number of active resources across all projects, realization projects, and 
completed projects. 

 The number of Project Managers with active projects grouped by initiative and access 
profile. 

 The number of Project Managers with active projects. 

 The number of resources with Project Leader/Project Manager role by initiative and 
access profile. 

 The number of active resources by initiative and access profile. 

 The number of active resources by initiative. 

 The total number of resources by initiative. 

 System Information 

 A count of system components 

To view the Usage Statistics Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Usage Statistics Report link. 
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Permissions Report 

Use the Permissions Report to view all resource access profiles and roles with their 
permissions.  

To view the Permissions Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Permissions Report link. 

Last Login Report 

Use the Last Login Report to view a log of all users who attempted to log into the system, login 
date, user ID, login ID, email address, first name, last name and the success of the login. 

To view the Last Login Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Last Login Report link. 

Scheduled Reports by Resource Report 

Use the Scheduled Reports By Resource Report to view a list of reports scheduled by 
resources. This report is generated in CSV format and includes the following information: 

 user report name  

 standard report name 

 if the report is emailed 

 email address (To, CC, and BCC) of the resources it is sent to  

 day of the week, day, month, and year the report is scheduled to run 

 scheduler's email address 

 scheduler's name 

 scheduler's status 

 date of the last report run attempt 

To view the Last Login Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Scheduled Reports by Resource Report link. 

Confidential Project Count by Resource Report 

Use the Confidential Project Count by Resource Report to view a list of all confidential projects 
in the system. This report is generated in CSV format and includes the following information: 

 count of confidential projects 

 project manager's email address 

 project manager's first name and last name 

 project manager's status 
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To view the Confidential Project Count by Resource Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Confidential Project Count by Resource Report link. 

Setting Resource Heat Map Thresholds 

Use the Set Resource Heat Map Thresholds link to edit the thresholds that control the colors in 
heat maps, including the Resource Planning List page, What-if View Scenario page, and all heat 
map reports. 

To set the heat map thresholds: 

1) Select the Resource & Security Admin tab. 

2) Click the Resource Heat Map Thresholds link. 

3) Edit the default Upper Threshold % column value for the Green, Amber and Red rows. The 
Lower Threshold % column value is automatically set based on the Upper Threshold %. 

4) Click Update. 

Timesheet Settings 

In This Section 

Configuring Time Reporting Categories ................................................................... 48 
Resource Admin Reports ........................................................................................ 50 
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Configuring Time Reporting Categories 

In This Section 
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Configuring Categories for Project Related Time Reporting 

EnterpriseTrack allows users to complete and submit timesheets for reporting the time spent on 
various project related and non-project related activities. The different categories for reporting 
time have to be created within the Time Reporting Categories section in the Administration 
module. 

1) Click the Resource & Security Admin tab. 

2) Click the Project Time Reporting Categories link. All the available categories are listed, by 
initiative. 

3) To modify an existing category, click the name of the category. 
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4) To create a new category, click the Create button. 

5) Specify whether it is a global category which will be available to users across initiatives. If 
not, you must choose the initiative with which it is to be associated. 

6) Enter a category name and an order ID. 

7) Click Update or Create as appropriate to save your changes. 

Note: Once a category is associated with a specific initiative it cannot be 
made a global category. You can create a new global category with the 
same name. 

Configuring Categories for Non-Project Time Reporting 

EnterpriseTrack allows users to complete and submit timesheets for reporting the time spent on 
various project related and non-project related activities. The different categories for reporting 
time have to be created within the Time Reporting Categories section in the Administration 
module. 

To create and manage non-project related time reporting categories: 

1) Click the Resource & Security Admin tab. 

2) Click the Non-Project Time Reporting Categories link. All the available categories are 
listed, by initiative. 

3) To modify an existing category, click the name of the category. 

4) To create a new category, click the Create button. 

5) Specify whether it is a global category which will be available to users across initiatives. If 
not, you must choose the initiative with which it is to be associated. 

6) Enter a category name and an order ID. 

7) Click Update or Create as appropriate to save your changes. 

Note: Once a category is associated with a specific initiative it cannot be 
made a global category. You can create a new global category with the 
same name. 

Configuring Categories for Non-Working Time Reporting 

EnterpriseTrack allows users to complete and submit timesheets for reporting the time spent on 
various project related and non-project related activities. The different categories for reporting 
time have to be created within the Time Reporting Categories section in the Administration 
module. 

To create and manage non-project related time reporting categories: 

1) Click the Resource & Security Admin tab. 

2) Click the Non-Working Time Reporting Categories link. All the available categories are 
listed, by initiative. 

3) To modify an existing category, click the name of the category. 
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4) To create a new category, click the Create button. 

5) Specify whether it is a global category which will be available to users across initiatives. If 
not, you must choose the initiative with which it is to be associated. 

6) Enter a category name and an order ID. 

7) Click Update or Create as appropriate to save your changes. 

Note: Once a category is associated with a specific initiative it cannot be 
made a global category. You can create a new global category with the 
same name. 

Resource Admin Reports 
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Usage Statistics Report 

Use the Usage Statistics Report to view account usage. This report displays the following 
information: 

 The number of initiatives loaded. 

 A count of resources that accessed the system in the past 7 to 180 days. 

 A count of projects updated in the past 7 to 180 days by initiative. 

 The number of Ideas created. 

 A count of proposals by initiative and status. 

 Project Information 

 A count of projects by initiative. 

 A count of projects by initiative and status. 

 A count of project components  

 Resource Information 

 The total number of active resources across all projects, realization projects, and 
completed projects. 

 The number of Project Managers with active projects grouped by initiative and access 
profile. 

 The number of Project Managers with active projects. 

 The number of resources with Project Leader/Project Manager role by initiative and 
access profile. 

 The number of active resources by initiative and access profile. 
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 The number of active resources by initiative. 

 The total number of resources by initiative. 

 System Information 

 A count of system components 

To view the Usage Statistics Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Usage Statistics Report link. 

Permissions Report 

Use the Permissions Report to view all resource access profiles and roles with their 
permissions.  

To view the Permissions Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Permissions Report link. 

Last Login Report 

Use the Last Login Report to view a log of all users who attempted to log into the system, login 
date, user ID, login ID, email address, first name, last name and the success of the login. 

To view the Last Login Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Last Login Report link. 

Scheduled Reports by Resource Report 

Use the Scheduled Reports By Resource Report to view a list of reports scheduled by 
resources. This report is generated in CSV format and includes the following information: 

 user report name  

 standard report name 

 if the report is emailed 

 email address (To, CC, and BCC) of the resources it is sent to  

 day of the week, day, month, and year the report is scheduled to run 

 scheduler's email address 

 scheduler's name 

 scheduler's status 

 date of the last report run attempt 

To view the Last Login Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Scheduled Reports by Resource Report link. 
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Confidential Project Count by Resource Report 

Use the Confidential Project Count by Resource Report to view a list of all confidential projects 
in the system. This report is generated in CSV format and includes the following information: 

 count of confidential projects 

 project manager's email address 

 project manager's first name and last name 

 project manager's status 

To view the Confidential Project Count by Resource Report: 

1) Click the Resource & Security Admin tab. 

2) Click the Confidential Project Count by Resource Report link. 

Setting Resource Heat Map Thresholds 

Use the Set Resource Heat Map Thresholds link to edit the thresholds that control the colors in 
heat maps, including the Resource Planning List page, What-if View Scenario page, and all heat 
map reports. 

To set the heat map thresholds: 

1) Select the Resource & Security Admin tab. 

2) Click the Resource Heat Map Thresholds link. 

3) Edit the default Upper Threshold % column value for the Green, Amber and Red rows. The 
Lower Threshold % column value is automatically set based on the Upper Threshold %. 

4) Click Update. 

Timesheet Settings 

In This Section 

Configuring Timesheet Creation Defaults ................................................................ 52 
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Configuring Timesheet Creation Defaults 

Use the Timesheet Creation Defaults page to set the default display of the Timesheet Create
page for all timesheet users. The default timesheet categories you select here are displayed 
when new timesheets are created by users. Users have the option to modify these default 
settings. 

To select the timesheet creation defaults: 

1) Click the Resource & Security Admin tab. 

2) Click the Timesheet Creation Defaults link. 
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3) For the Display Project Time Reporting category, select from one of the following options: 
Show All Projects, Show Zero Projects, or Show Projects from Previous Period. 

4) Select the check boxes Display Non-Project Time Reporting Categories and Display 
Non-Working Time Reporting Categories to display these categories when new 
timesheets are created. 

5) Click Save. 

Configuring Time Reporting Categories 

In This Section 
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Configuring Categories for Project Related Time Reporting 

EnterpriseTrack allows users to complete and submit timesheets for reporting the time spent on 
various project related and non-project related activities. The different categories for reporting 
time have to be created within the Time Reporting Categories section in the Administration 
module. 

1) Click the Resource & Security Admin tab. 

2) Click the Project Time Reporting Categories link. All the available categories are listed, by 
initiative. 

3) To modify an existing category, click the name of the category. 

4) To create a new category, click the Create button. 

5) Specify whether it is a global category which will be available to users across initiatives. If 
not, you must choose the initiative with which it is to be associated. 

6) Enter a category name and an order ID. 

7) Click Update or Create as appropriate to save your changes. 

Note: Once a category is associated with a specific initiative it cannot be 
made a global category. You can create a new global category with the 
same name. 

Configuring Categories for Non-Project Time Reporting 

EnterpriseTrack allows users to complete and submit timesheets for reporting the time spent on 
various project related and non-project related activities. The different categories for reporting 
time have to be created within the Time Reporting Categories section in the Administration 
module. 

To create and manage non-project related time reporting categories: 

1) Click the Resource & Security Admin tab. 
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2) Click the Non-Project Time Reporting Categories link. All the available categories are 
listed, by initiative. 

3) To modify an existing category, click the name of the category. 

4) To create a new category, click the Create button. 

5) Specify whether it is a global category which will be available to users across initiatives. If 
not, you must choose the initiative with which it is to be associated. 

6) Enter a category name and an order ID. 

7) Click Update or Create as appropriate to save your changes. 

Note: Once a category is associated with a specific initiative it cannot be 
made a global category. You can create a new global category with the 
same name. 

Configuring Categories for Non-Working Time Reporting 

EnterpriseTrack allows users to complete and submit timesheets for reporting the time spent on 
various project related and non-project related activities. The different categories for reporting 
time have to be created within the Time Reporting Categories section in the Administration 
module. 

To create and manage non-project related time reporting categories: 

1) Click the Resource & Security Admin tab. 

2) Click the Non-Working Time Reporting Categories link. All the available categories are 
listed, by initiative. 

3) To modify an existing category, click the name of the category. 

4) To create a new category, click the Create button. 

5) Specify whether it is a global category which will be available to users across initiatives. If 
not, you must choose the initiative with which it is to be associated. 

6) Enter a category name and an order ID. 

7) Click Update or Create as appropriate to save your changes. 

Note: Once a category is associated with a specific initiative it cannot be 
made a global category. You can create a new global category with the 
same name. 

Managing Estimated Time to Complete for Timesheet Settings 

To enable the Estimated Time to Complete (ETC) field for timesheets: 

1) Click the Resource & Security Admin tab. 

2) Select the Manage Estimated Time To Complete For Timesheet Settings link. 

3) Choose an initiative and click the [Edit] link next to it. The Edit Estimated Time to Complete 
for Timesheet Settings screen is displayed. 

4) Choose if you want to enable the ETC field for timesheets. 

5) Choose if you require resources to enter their ETC for activities before submitting their 
timesheets. 
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6) Click Update. 

Manage Allowed Grace Period in Days for Activities in Timesheet 

To change the grace period for timesheet reporting: 

1) Click the Resource & Security Admin tab. 

2) Select the Manage Allowed Grace Period In Days For Activities in Timesheet Settings
link. 

3) Choose an initiative and click the [Edit] link next to it. The Edit Allowed Grace Period In 
Days For Activities In Timesheet Settings screen is displayed. 

4) Specify how many days past the activity completion date can team members continue to 
report effort. 

5) Specify how many days before the activity start date can team members start reporting 
effort. 

6) Click Update. 

Security Administration 
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Managing Resource Password Hint Questions 

You can use the Manage Resource Password Hint Questions page to create and manage hint 
questions. The questions are emailed to a resource when they forget their password.  

To manage password hint questions: 

1) Click the Resource & Security Admin tab. 

2) Select the Manage resource password hint questions link. 

3) Click the Create Question button. 

4) Enter a question. 

5) Click Create. 

To edit a question: 

1) Click the Resource & Security Admin tab. 

2) Select the Manage resource password hint questions link. 

3) From the Actions column, click Edit. 

4) Make the required changes on the Edit Question page and click Update. 

To delete a question: 
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 From the Actions column, click the Delete. 

Managing Portal Settings 

You can use the Portal Settings page to create a user ID and password to access the Idea 
Portal. Users can use this ID and password to enter the Idea Portal without to logging into 
EnterpriseTrack. 

1) Select the Resource & Security Admin tab. 

2) Click the Portal Settings link. The Edit Portal Settings screen is displayed. 

3) Enter a portal ID and Password. 

4) Click Update. 

Managing Login Warning Message 

You can use the Login Warning Message page to add any warning message or terms of use you 
would like displayed on the Login screen. 

To edit the login warning message: 

1) Select the Resource & Security Admin tab. 

2) Click the Login Warning Message link. The Edit Login Warning Message screen is 
displayed. 

3) Enter the message. 

4) Click Update. 

Configuring IP Address Restriction 

You can use the Configure IP Address Restriction page to restrict EnterpriseTrack login access 
and Portal access to specified IP addresses. You can specify IP address in X.X.X.X format 
(where X ranges from 0 to 255), or a CIDR IP address in X.X.X.X/N format (where X ranges from 
0 to 255 and N from 8 to 32). 

To enter the addresses: 

1) Select the Resource & Security Admin tab. 

2) Click the Configure IP Address Restriction link. 

3) Click Add Valid IP Addresses. 

4) Enter the IP addresses. 

5) Select the check box Restrict Access to Idea Portal to allow users from the specified IP 
address to access the Idea Portal. 

6) Select the check box Restrict Login Access to allow users from the specified IP address to 
access the EnterpriseTrack login. 

7) Click Save. 
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Temporary Administrator Settings 

To activate a temporary administrator: 

1) Select the Resource & Security Admin tab. 

2) Click the Temporary Administrator Settings link. 

3) Select Activate from the Temporary Administrator State option. 

4) Click the Calendar picker and select a deactivation date. 

5) Enter the first name and last name of the temporary administrator. 

6) Enter an email address. 

7) Select when you want the temporary password to expire. 

8) Click Update. 

To deactivate a temporary administrator: 

1) Select the Resource & Security Admin tab. 

2) Click the Temporary Administrator Settings link. 

3) Select Deactivate from the Temporary Administrator State option. 

Application Configuration 
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Configuring Roadmaps 

A roadmap or WBS (Work-breakdown Structures) is a hierarchical arrangement of activities, 
tasks or milestones that are required to complete a project. A roadmap divides a project into 
discrete phases or top-level activities and each phase is further broken down into multiple work 
elements or tasks. A roadmap is associated with one or more activity templates or phases and 
each activity template contains one or more activities. These activities can be tasks, 
deliverables, milestones, or tollgates. 

The process of configuring roadmap involves the following steps: 
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1) Creating activity subtypes. Typically, these are defined only for top-level activities or phases. 
Activity subtype is the name that displays in the User Interface for a phase or a top-level 
activity. 

2) Configuring an activity template for each phase or top-level activity you have defined in your 
system. 

3) Populating an activity template with work elements or activities.  An activity template 
contains multiple activities like tasks, deliverables, tollgates, etc. 

4) Configuring a roadmap (WBS). 

5) Populating a roadmap with phases or activity templates. 

6) Associating a roadmap with project types. 

7) Creating resource assignment types 

Once you have configured roadmaps, Project Managers can use these pre-defined roadmaps to 
quickly plan and execute projects.   

You can also create non-WBS roadmaps, which are a set of activities that are associated with a 
project but are not part of the project WBS. For example, change requests, issues, notes, etc.  

Note: Some of the choices you see while creating activity templates and 
roadmaps are determined during the initial system configuration.  
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Creating Activity Sub Types 

Activity sub types are the user visible names for the phases or activity templates you have 
defined. For example for the activity template Phase, you can have a sub type called Planning, 
or Testing. 

To create activity sub types: 

1) Click the Application Configuration tab. 

2) Select the Activity Sub Types/ Phase Name link. 

3) Click the Create a New Activity Sub Type button. 

4) Select the activity type from the drop-down menu. For example, Phase. 

5) Enter a name for this activity sub type. For example, you could create a sub type called 
Requirements Analysis, Planning, Designing, or Testing. 
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6) Enter the lower and upper cycle time range (in days). This is the upper and lower duration 
range for this activity sub type. 

7) Click Create. 

Working with Activity Templates 

You can create activity templates for each phase of your project, and each activity template can 
be configured to have an ordered list of tasks and deliverables. You can specify tools, create 
tollgates, set approvers, and set resources. 

You can set tollgates to be effort-based or duration based: 

 Effort-based  

This is based on the effort required to get a job done. For example, a paint job may require 
40 hours for 4 people working for 5 hours every day to complete the job.  

 Duration-based  

If there is a required time for the job to be completed. For example, in the instance of the 
paint job above, it may take a certain amount of time for the paint job to dry up. The lead time 
cannot be reduced by putting more people to dry the paint.  

Activity templates are used in roadmaps and changes made to an activity template affect all 
roadmaps that refer to the template. Existing projects are not affected, only future projects are 
affected by the template changes.  
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Creating Activity Templates 

To create a new activity template: 

1) Click the Application Configuration tab. 

2) Select the Activity Templates link.  

3) Click the Create a New Activity Template button. The Create Activity Template page is 
displayed. 

4) In installations that have multiple initiatives configured within the same system, select the 
appropriate initiative from the Initiative pull-down menu. 

5) Based on the initiative, the Roadmap family pull-down will be populated. Choose the 
appropriate roadmap family for your new activity template. 

6) Select the activity type for which this template is being created. 
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7) Select the Activity Sub Type for this activity template. 

8) Enter a name for the activity template. This name will be used within the system and will not 
be visible to any user other than the administrator. 

9) From the drop-down list select if this activity template will be used as a template or as 
creation_defaults. You can choose to use this as a template for creating activities on 
roadmaps, or as creation_defaults. Creation_defaults are used to set default field values so 
new activities on the Roadmap appear as in-line rows. 

10) You can also enter a description and the estimated time duration (in days) for this activity. 
This will be the default duration for this particular activity in every project that uses this 
activity template. 

11) Select a default Labor Expense Type (LET) from the drop-down list. 

12) From the drop-down menu select the Plan Effort Type and Actual Effort Type. 

13) Select if you want to enforce resources. If you select Yes, then select the mandatory 
resources. You can also the select if all resources are required for this activity type. 

14) From the Approvers pane, you can manage permissions for the approvers and you can also 
choose to enforce approvals and approvers for the activity template. 

15) From the Percentage Completion pane, you can select how you want the percentage 
complete to be calculated. 

16) Click Create to save your changes. 

Editing Activity Templates 

Editing an activity template consists of modifying its name, description and time duration. 

To edit an existing activity template: 

1) Click the Application Configuration tab. 

2) Click the Activity Templates link. You will see a list of all the existing activity templates. 

3) Locate the template you want to edit and click the [Edit] link in the Action column. 

4) Make the necessary changes in the Edit Activity Template page. 

5) Click Update to save your changes. 

Copying Activity Templates 

If you want to create multiple activity templates that are only slightly different from each other, 
you can use the copy function. After you are done copying the new activity template, you can 
modify the deliverables and tasks. See topic Editing Activities and Tasks (on page 62). 

To copy an existing activity template: 

1) Click the Application Configuration tab. 

2) Click the Activity Templates link. You will see a list of all the existing activity templates. 

3) Locate the template you want to copy and click the [Copy] link in the Action column. 

4) Enter a name. 

5) Click Copy. A complete copy of the activity template is created. 
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Deleting Activity Templates 

To delete an existing activity template: 

1) Click the Application Configuration tab. 

2) Click the Activity Templates link. You will see a list of all the existing activity templates. 

3) Locate the template you want to delete and click the [Delete] link in the Action column. 

4) Click OK in the pop-up dialog box to confirm the deletion. 

Adding Deliverables and Tasks to Activity Templates 

For an activity template to be meaningful, each activity must have its own set of deliverables, 
which can be broken down further into tasks. Since EnterpriseTrack allows you to create multiple 
activity templates for an activity, you can define deliverables and tasks for each activity template. 

Adding deliverables and tasks 

Once the template has been created, you can continue to add the deliverables and tasks. 

To add deliverables and tasks to an activity template: 

1) Click the Application Configuration tab. 

2) Click the Activity Templates link to view a list of all the existing activity templates. 

3) Locate the template and click on its name. The Activity Template Explorer page is displayed. 

4) Click the  icon to view the contents of the template. 

5) Add peer or child activities. 

a. Click the  icon to add a peer activity. You can add gates, tollgates, deliverables, 
phases, and tasks to the activity template. 

b. Click the  icon to add a child activity. You can add gates, tollgates, deliverables, 
phases, and tasks to the activity template. 

Note: You cannot add peer activities to a top level activity. However, you 
can add child or peer level activities to a child activity. 

6)  Enter a name, sub type and description for this activity. 

7) You can enter the number of estimated hours for this activity and this will be carried forward 
when the roadmap is used for a project. Projects Managers can check the available hours for 
each user and make sure it is in line with the estimated hours for an activity before assigning 
the deliverable. 

8) Set the initial status, select which roles will be allowed to own this activity, and whether 
ownership should be enforced or not. 

9) You can also choose tools that are associated with this activity. The system allows you to 
enter the names of tools that have not yet been uploaded into the Knowledge Base under 
Tool Templates. Click the Add link next to the All Available Tools field and enter a name 
in the pop-up dialog box. 
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Note: You must upload this tool in the Knowledge Base. 

10) Click the Save button to save your changes. 

Adding Dependencies between Activities 

To add dependencies between activities: 

1) Click the Application Configuration tab. 

2) Click the Activity Templates link to view a list of all the existing activity templates. 

3) Locate the template and click on its name. The Activity Template Explorer page is displayed. 

4) Select an activity. The Details pane is displayed. 

5) Select the Dependencies tab. 

6) Click the Add New icon. 

7) Add a predecessor by entering the activity name. You can also click the View link to find the 
dependent activity. 

8) Enter the type of dependency. Choose from Start to Start, Start to Finish, Finish to 
Finish, or Finish to Start. The start date is computed from the completion date of the 
predecessor tasks and the completion date is calculated from the start date and the duration 
of the predecessor activity. 

9) Click Save. 

Note: The Dependencies tab is displayed only if the initiative of the 
activity template has the Enable Activity Level Dependencies feature 
enabled, and the Activity type has Dependencies enabled. 

Editing Activities and Tasks 

To edit activities and tasks on an activity template: 

1) Click the Application Configuration tab. 

2) Click the Activity Templates link to view a list of existing activities templates. 

3) Locate the template you want to edit and click on the name of the activity template. The 
Activity Template Explorer page is displayed. 

4) Click the  icon to view the contents of the activity template. 

5) Click on the name of the deliverable or task you want to modify. 

6) Make the necessary changes. 

7) Click Update to save the changes. 

Working with Roadmaps 

Project Managers can use these pre-determined roadmaps to quickly create projects. 
Roadmaps are made up of activity templates, which in turn are made up of deliverables that are 
broken down into tasks. 
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Creating Roadmaps 

To create a new roadmap: 

1) Click the Application Configuration tab. 

2) Select the Roadmaps link. The Roadmap List page is displayed. 

3) Click the Create New Roadmap button. 

4) Select an initiative.  

5) Enter a name for the roadmap. This name is used within the system and is not visible to any 
user other than the administrator. 

6) Select an activity template from the Mandatory Activity Template pull-down menu. All 
roadmaps must have at least one activity template. 

7) Enter the Mandatory Realization Activity Template. 

8) Enter other relevant information pertaining to this roadmap. See table below for a description 
of these fields. 

9) Click Create Roadmap. 

Field Description

Roadmap Family The options you can choose are based on the initiative you 
selected. 

Is Phase Gated 
Roadmap? 

Select Yes if you want each phase on the roadmap to be 
completed before starting the next phase. 

Show Stages as Tabs? Select Yes to have top-level activities appear as separate 
tabs on the Project Roadmap page. 

Select No to have all the top-level activities appear on the 
same tab. 

Enable WBS Code on 
Activity 

Select Yes if you want to the WBS to have a hierarchical 
numbering structure, for example 1, 1.1, 1.1.1, etc. for 
activities displayed on a project roadmap. 

Allow Template 
Generated Activities to 

Select Yes if you want users to modify or delete the name of 
a template generated activity. Other attributes within the 
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be Modified? template can also be modified. 

Scheduling Mode Select Manual or Semi-Automatic
Manual: EnterpriseTrack does not update the dates on the 
project roadmap when dependent activities are rescheduled 
or modified. When dependent activities are rescheduled, 
you have to manually update the activity dates on the 
Project Roadmap page. 
Semi-Automatic: EnterpriseTrack updates the dates when 
dependent activities are rescheduled. When dependent 
activities are rescheduled, you can click the Schedule
button on the Project Roadmap page for EnterpriseTrack to 
update the activity dates. 

Resource Required to 
Complete Activities at 
Top Level? 

Select Yes if you require resources to be assigned to 
top-level activities in order to close them. 
Select No if you do not require a resource to be assigned to 
top-level activities. 

Select Activity Type Specific if you want this value to be 
the same as the Activity Type setting. 

Resource Required to 
Complete Activities at 
Other Level? 

Select Yes if you require resources to be assigned to 
activities at other levels in order to close them. 
Select No if you require no resource to be assigned. 

Select Activity Type Specific if you want this value to be 
the same as the Activity Type setting. 

Allowed Activity Types at 
Other Levels 

Choose the Activity Types allowed at other levels. 

Activity Type to 
Creation-Default 
Mappings 

If activity type to creation default mapping exists, you can 
select it from the pull-down menu. This mapping allows you 
to set default field values for roadmap activities so new 
activities appear on the roadmap as in-line rows. 

Is MSP Integration 
Allowed? 

Select Yes if you want to allow MSP (Microsoft Project) 
integration. You must select a template file before you can 
export or import data. Click the Browse button and select a 
template. 

Computation mode for 
dates and duration 

Internal: EnterpriseTrack computes the dates and duration.
External read-only: The calculation for dates and duration 
comes from MS Project. Project Managers cannot edit the 
values in EnterpriseTrack. 
External read-write: The calculation for dates and duration 
comes from MS Project. Project Managers can change the 
values in EnterpriseTrack. 
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Computation mode for 
duration and efforts 

Internal: EnterpriseTrack computes the duration and effort. 
External read-only: The calculation for duration and effort 
comes from MS Project. Project Managers cannot edit the 
values in EnterpriseTrack. 
External read-write: The calculation for duration and effort 
comes from MS Project. Project Managers can change the 
values in EnterpriseTrack. 

Computation mode for 
efforts and cost 

Internal: EnterpriseTrack computes the effort and cost. 
External read-only: The calculation for effort and cost 
comes from MS Project. Project Managers cannot edit the 
values in EnterpriseTrack. 
External read-write: The calculation for effort and cost 
comes from MS Project. Project Managers can change the 
values in EnterpriseTrack. 

Editing Roadmaps 

To edit a roadmap: 

1) Click the Application Configuration tab. 

2) Click the Roadmaps link. The Roadmap List page is displayed. 

3) Locate the roadmap you want to edit and click the [Edit] link in the Action column. 

4) Make the necessary changes. 

5) Click Update to save your changes. 

Copying Roadmaps 

If you want to create multiple roadmaps that are only slightly different from each other, you can 
use the copy function. When you have finished creating a new roadmap, you can modify its 
activity template. See topic Adding Activity Templates to a Roadmap (on page 66).  

To copy an existing roadmap: 

1) Click the Application Configuration tab. 

2) Click the Roadmaps link. The Roadmap List page is displayed. 

3) Locate the roadmap you want to copy and click the [Copy] link in the Action column. 

4) Enter a name, and click Copy. A complete copy of the roadmap is created. 

5) Locate the new roadmap and go on to modify its activity templates by clicking on the name 
of the roadmap. 

Deleting Roadmaps 

To delete an existing roadmap: 

1) Click the Application Configuration tab. 
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2) Click the Roadmaps link. The Roadmap List page is displayed. 

3) Locate the roadmap you want to delete and click the [Delete] link in the Action column. 

4) Click Ok in the pop-up dialog box to confirm the deletion. 

Changing Status 

To edit the status of a roadmap: 

1) Click the Application Configuration tab. 

2) Click the Roadmaps link. The Roadmap List page is displayed. 

3) Locate the roadmap you want to edit and click the [Change] link in the Status column. 

4) Change the status of the roadmap. Select Invalid if you do not want users to use obsolete 
roadmaps when creating or editing projects. You cannot create, or edit the roadmap if the 
status is Invalid.  If the status is Valid, users can use this roadmap. If you select Archived, 
the roadmap cannot be used while creating projects but can be used to edit or filter. 

5) Click Update to save your changes. 

Note: In read-only pages, the Archived roadmaps are suffixed with ^ and 
Invalid roadmaps are marked with x. While creating projects only valid 
roadmaps are displayed and while editing, the current roadmap is 
displayed, but only valid roadmaps are displayed in the drop down 
option. Archived roadmaps do not cause any validation errors. 

Adding Activity Templates to a Roadmap 

To add activity templates to a roadmap, 

1) Click the Application Configuration tab. 

2) Click the Roadmaps link. The Roadmap List page is displayed. 

3) Locate the roadmap to which you want to add an activity template. 

4) Click on its name. You will see all the activities that are currently part of the roadmap. 

5) Click the Add Activity Template button. 

6) Select the activity templates you want to add from the Activity Templates pull-down menu. 

7) Enter the Order ID for this new activity to tell the system where it should be located in the 
roadmap. You can click the Existing Order IDs link to view the existing list before entering a 
number in this field. 

8) Click Add Activity Template. 

Editing MS Project Import and Export 

To edit a roadmap to allow MS Project import/export: 

1) Click the Application Configuration tab. 

2) Click the Roadmaps link. The Roadmap List page is displayed. 

3) Locate the roadmap you want and click the [MS Project] link in the Action column. 
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4) Select Yes if you want to allow MS Project integration. 

5) Click the Browse button to select a MS Project template file (. mpt). 

6) Click Update.

Working with Non-WBS roadmaps 

In This Section 
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Creating a Non-WBS Roadmap 

You can define a list of activities that are outside of the project roadmap. These activities are 
defined as non-WBS activities. This may be a list of change requests, discussions, risks, etc. 
These activities are not tied to the project roadmap, but are associated with a project and are 
displayed on the Left Navigation Bar. 

To create a non-WBS roadmap: 

1) Click the Application Configuration tab. 

2) Select Non-WBS Roadmaps link. The Non-WBS Roadmap List screen is displayed. 

3) Click the Create a New Non-WBS Roadmap button. 

4) Select an initiative from the drop-down list. 

5) Based on the initiative, the Roadmap family pull-down will be populated. Choose the 
appropriate roadmap family. 

6) Enter a name for this roadmap. 

7) Click the Change button and select an icon for this roadmap. This icon will be displayed in 
Left Navigation Bar. 

8) Enter a left navigation menu name for this roadmap. 

9) Choose if you want to enable WBS code on activity. 

10) Select an Activity Type for this roadmap. 

11) If activity type to creation default mapping exists, you can select it from the pull-down menu. 
This mapping allows you to set default field values for roadmap activities so new activities 
appear on the roadmap as in-line rows. For more information, see Creating Activity 
Templates (on page 59). 

12) Click the Create Non-WBS Roadmap button. 

Managing Non-WBS Roadmaps 

Editing a Non-WBS Roadmap 

To edit a non-WBS roadmap: 

1) Click the Application Configuration tab. 

2) Select Non-WBS Roadmaps link. The Non-WBS Roadmap List screen is displayed. 
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3) Click the [Edit] link next to the roadmap you want to edit. 

4) Click Update after you have made changes to roadmap. 

Deleting a Non-WBS Roadmap 

To delete a non-WBS roadmap: 

1) Click the Application Configuration tab. 

2) Select Non-WBS Roadmaps link. The Non-WBS Roadmap List screen is displayed. 

3) Click the [Delete] link next to the roadmap you want to delete. 

4) Click OK to confirm the deletion. 

Changing the Status 

To change the status of a non-WBS roadmap: 

1) Click the Application Configuration tab. 

2) Select Non-WBS Roadmaps link. The Non-WBS Roadmap List screen is displayed. 

3) Select a roadmap and click the [Change] link under the Status column. 

4) Choose a status (Valid, Invalid, or Archived) for this roadmap. 

5) Click Update to save your changes. 

Working with Dependency Types 

To view the current dependency types: 

1) Click the Application Configuration tab. 

2) Select the Dependency Types link. A list of all dependency types is displayed. 

Editing Dependency Types 

To edit dependency types: 

1) Click the Application Configuration tab. 

2) Select the Dependency Types link. You will see a list of all the existing dependency types. 

3) Click the Edit link associated with the dependency type you want to modify. The Edit 
Dependency Types page is displayed. 

4) Enter the new Dependency Type Name and the Dependency Type Code. 

5) Click the Update button to make the changes. 

Note: There are four different predecessor types. You can change the 
default display name at the initiative level. 

Working with Project Types 

Project types are a way of classifying projects for reporting purposes. A project type may be 
associated with one or more roadmaps. For example, you may have a project type called 
Baseline associated with DMAIC and DMADV roadmaps, and another project type called Just 
Do It associated with the DMAIC-Short and DMADV roadmaps. 
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Adding a Project Type 

To create a new project type: 

1) Click the Application Configuration tab. 

2) Click the Project Type link. You will see a list of all the existing project types. 

3) Click the Create New Project Type button. The Pulldown Values for Project Type page is 
displayed. 

4) In installations that have multiple initiatives configured within the same system, select the 
appropriate initiative from the Initiative pull-down menu. 

5) Enter a name for the roadmap. This name will be used within the system and will not be 
visible to any user other than the administrator. 

6) Based on the initiative, the Roadmap family pull-down will be populated. Choose the 
appropriate roadmap family for your new project type. 

7) Select the roadmaps that are to be associated with this project type. Hold down the Control
key and click to select multiple values. 

8) Click Create to save the new project type. 

Editing a Project Type 

To edit a project type: 

1) Click the Application Configuration tab. 

2) Click the Project Type link. You will see a list of all the existing project types. 

3) Click the name of the project type to be edited. 

4) Make the required changes and click Update to save your changes. 

Working with Resource Assignment Types 

Resource Assignment allows you to manage responsibility charting. You can identify functional 
areas, key activities, and decision points by defining roles and responsibilities. There are four 
different types of resource types (RACI) that you can assign in a project: 

 Accountable (A): Individual who is ultimately responsible for a project with a yes/no authority. 
One function can have only one accountable person. 

 Responsible (R): Individual working on the activity and responsible for action and execution 
of the plan. 

 Consult (C): Individual who must be consulted prior to a final decision or action. This involves 
a two-way communication. 

 Inform (I): Individual that needs to know of the decision or action. This is usually a one-way 
communication. 

Adding a Resource Assignment Type 

To create a new resource assignment type: 

1) Click the Application Configuration tab. 
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2) Select the Resource Assignment Types/ RACI link. You will see a list of all the existing 
resource assignment types. 

3) Click the Create New Assignment Type button. The Create Resource Assignment Type 
page is displayed. 

4) In installations that have multiple initiatives configured within the same system, select the 
appropriate initiative from the Initiative pull-down menu. 

5) Enter a name and a short name for the new assignment type. 

6) Select Yes to enable this assignment type.  

7) Select Yes to add this type towards project finance calculation.  

If Consider for Project Finances setting is Yes, then AET effort flows to finances. If set to 
No, then users assigned with this assignment type will not have their effort on the activity 
monetized into the project finances 

8) Enter the Sort Order for this new assignment type. You can click the Order of Existing 
Types link to view the existing list before entering a number in this field. 

9) Click Save. 

Editing a Resource Assignment Type 

To edit an existing resource assignment type: 

1) Click the Application Configuration tab. 

2) Select the Resource Assignment Types/ RACI link. You will see a list of all the existing 
resource assignment types. 

3) Click the Edit link associated with the resource assignment type you want to modify. The 
Edit Resource Assignment Type page is displayed. 

4) Make the required changes and click Update to save your changes. 

Configuring Status Indicator 

You must configure and manage the status indicators displayed in the Tree pane within the 
Strategy section of EnterpriseTrack. You can create multiple status indicator lists. Each status 
indicator list can have a number of items, each with its own color and value assigned to it. You 
can also choose to have the indicator icon blink. 

Creating a Status Indicator 

To create a new status indicator: 

1) Click the Application Configuration tab. 

2) Select the Status Indicator link. 

3) Click the Create a New Status Indicator button. 

4) Add items as required and specify the color and value for each one 

5) Click the Add Status Indicator button to add this configuration to the list of status indicators 
in the system. 
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Project Settings 
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Configuring Percentage Completion 

Use the Percent Completion Type page to select how EnterpriseTrack should calculate the 
percentage complete for projects. For each initiative defined in your system, you can select a 
default from the following choices: 

 Manual Mode: Users can manually enter a number from the Project Basics page. 

 Effort-based (Actual vs Planned Effort for Immediate Children): Percentage complete is 
calculated based on the actual effort and the planned effort of all top-level tasks. 

 Effort-based (Actual vs Planned Effort for All Children): Percentage complete is 
calculated based on the actual effort and the planned effort of all tasks. 

 Effort-based (Planned Completed vs Total Planned Effort for Immediate Children): 
Percentage complete is calculated based on the planned completed effort and the planned 
effort of all top-level tasks. 

 Effort-based (Planned Completed vs Total Planned Effort for All Children): Percentage 
complete is calculated based on the planned completed effort and the planned effort of all 
tasks. 

 Duration-based (Actual vs Planned Duration for Immediate Children): Percentage 
complete is calculated based on the actual duration and the planned duration of all top-level 
tasks. 

 Duration-based (Actual vs Planned Duration for All Children): Percentage complete is 
calculated based on the actual duration and the planned duration of all tasks. 

 Duration-based (Planned Completed vs Total Planned Duration for Immediate 
Children): Percentage complete is calculated based on the planned completed duration and 
the planned duration of all top-level tasks. 

 Duration-based (Planned Completed vs Total Planned Duration for All Children):  
Percentage complete is calculated based on the planned completed duration and the 
planned duration of all tasks. 

 Count-based (Completed vs Total Count for Immediate Children): Percentage complete 
is calculated based on the number of completed tasks and the total number of top-level 
tasks. 

 Count-based (Completed vs Total Count for All Children): Percentage complete is 
calculated based on the number of completed tasks and the total number of all tasks. 

 To configure the percent completion type: 
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1) Click the Application Configuration tab. 

2) Select the Percent Completion Type link. 

3) Click the [Edit] link next to your initiative. 

4) From the drop-down menu, select the percent completion type. 

5) Click Update to save your changes. 

Auto Close Parent Activity 

Use the Auto Close Parent Activity page to automatically close parent activities when all tasks 
and deliverables associated with the parent activity are complete. For each initiative you can 
choose to auto close parent activities. 

If you select Yes, then the parent activity is automatically closed when the last deliverable in 
current phase is marked complete. The project phases automatically advance till the project is in 
the last phase. After all deliverables in the last phase are closed, the last phase remains open till 
the Project Lead or a user with project close permission clicks on the Close Project button and 
closes the project. 

If you select No, you must manually close each phase to move to the next phase. 

To modify the auto-close feature: 

1) Click the Application Configuration tab. 

2) Select the Auto Close Parent Activity link. 

3) Click the [Edit] link next to your initiative. 

4) Select Yes or No. 

5) Click the Update button to save your changes. 

Official Phase Start and Close Defaults 

Use the Official Phase Start and Close Defaults page to choose how you want the phase start 
date and the phase close date to be calculated. 

To set the official phase start and close defaults: 

1) Click the Application Configuration tab. 

2) Select the Official Phase Start and Close Defaults link. 

3) Click the [Edit] link next to default you want to change. 

4) Make your selection. 

5) Click the Update button to save your changes. 

Manage Detail Section Display Preference 

You can set how you want the detail section to display. You can choose to have it in the main 
page, as a pop-up or as a split pane. 

To modify the detail section display mode: 

1) Click the Application Configuration tab. 
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2) Select the Detail Section Display Preference link. 

3) Click the [Edit] link next to the initiative. 

4) From the pull-down menu select from Split Pane Screen, Pop-up Screen, or Main Screen. 

5) Click the Update button to save your changes. 

Specify Levels to Pre-fill 

Use the Specify Levels to Pre-fill page to select the organizational levels you want to 
pre-populate. The levels are pre-filled in the Ideas, Proposals, and Projects pages based on the 
profile of the user that is logged in. 

To choose a level: 

1) Click the Application Configuration tab. 

2) Select the Org Levels to Pre-fill link. 

3) Click the Edit link next to your initiative. 

4) Specify a level from the drop-down menu. 

5) Click Update. 

Manage Project Cycle Time Mode 

To manage the project cycle time mode: 

1) Click the Application Configuration tab. 

2) Select the Project Cycle Time Mode link. 

3) Click the [Edit] link next to the initiative. 

4) From the pull-down menu select from Compute Cycle Time from Project Duration, or 
Compute Cycle Time from Summation of Cycle Times of Top Level Activities. 

5) Click the Update button to save your changes. 

Set Minimum Slacks for Critical Path 

Slack is the amount of time a task can be delayed without impacting the start date of a 
subsequent task. Use the Minimum Slack for Critical Path link to enter the minimum slack (in 
days) after which a task will be on the critical path. 

To set the minimum slack: 

1) Click the Application Configuration tab. 

2) Click Minimum Slack for Critical Path. 

3) Enter the minimum slack. 

4) Click Update. 
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Configuring Organizational Hierarchy 

Oracle recommends that you create an organizational hierarchy to ensure that all your 
resources, ideas, proposals and projects are associated with appropriate units within your 
organization. You can specify five levels in your organization hierarchy; the first two levels are 
always displayed, the other three are displayed only if it was set up during the initial 
configuration of your system. Your system may be configured to require you to enter values for 
each of the five levels.  

The default levels, hierarchies and the dependencies between the levels are created during the 
initial configuration of the system. A sample system might contain the following levels: 

1) Division 

2) Business Unit 

3) Business Sub-unit 

4) Location 

5) Regions 

You can add, edit, and delete values within each level using the links under Organization 
Hierarchy. 

In This Section 

Adding New Values ................................................................................................. 74 
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Creating Hierarchical Relationships ......................................................................... 76 

Adding New Values 

To add new values to each level of your organization hierarchy: 

1) Select the Application Configuration tab. 

2) Select a level from the Organizational Hierarchy section. For example Division, Business 
Unit, Business Subunit, Location, or Regions. The names of these levels may vary 
depending on your configuration. 

3) Click Create a New Division. The name of this button is based on the level you selected in 
the previous step. 

4) Select the Bulk Insert checkbox to add multiple values at the same time. 

5) Enter a name. 

6) Enter a charge back code. This field is optional. 

7) Click Create. 
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Editing Existing Values 

You can change the name, charge back code, and status of any of the existing values. You can 
modify the status of any of the five levels of your organization hierarchy to: 

 Valid: Users can use this level when adding or editing resources, ideas, proposals, or 
projects. 

 Invalid: Users cannot use this level. 

 Archived: Users can use this level when editing or filtering existing resources, ideas, 
proposals or projects. The historic value is preserved but it cannot be used when creating 
new projects.  

Changing the status on one level of the hierarchy can indirectly affect the other four levels. For 
example, if you mark BU1 as Archived and Europe is Invalid then the overall relationship status 
for:  

  Division1 → BU2 → Asia → China → Shanghai is Valid. 

  Division1 → BU1^→ Asia → China → Shanghai is Archived. 

  Division1 → BU1^→ Europe x → England → London is Invalid. 

In read-only pages, the archived hierarchies are suffixed with ^ and invalid hierarchies are 
marked with an x. When creating new projects only valid hierarchies are displayed in the 
drop-down option. When editing existing projects, the current hierarchy is displayed and only 
valid hierarchies are displayed in the drop-down option. Archived hierarchies do not cause any 
validation errors.  

To edit the existing values for each level of your organization hierarchy: 

1) Select the Application Configuration tab. 

2) Select the appropriate level from the Organizational Hierarchy section, for example Division,
Business Unit, Business Subunit, Location, or Regions. The names of these levels may 
vary depending on your configuration. 

3) Click the Create a New Division button. The name of this button varies based on the level 
you selected in the previous step. 

4) Locate the value you want to edit and click the [Edit] link. 

5) Modify the name, charge back code, or status. 

6) Click the Update button. 

Deleting Values 

To delete existing values in your organizational hierarchy: 

1) Select the Application Configuration tab. 

2) Select the appropriate level from the Organizational Hierarchy section, for example Division. 
The names of these levels may vary depending on your configuration. A list of values for the 
level you selected displays.  

3) Click the [Delete] link next to value you want to delete. 

4) Click OK to confirm the deletion. 
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Note: Deleted values are not available anywhere in the system. If there 
are hierarchies and dependencies, you must first resolve these before 
deleting the values. 

Reassigning Relationships 

You can reassign all resources, ideas, proposals, and projects belonging to one Business Unit to 
another Business Unit within your organization hierarchy. 

To reassign relationships: 

1) Select the Application Configuration tab. 

2) Select the appropriate level from the Organizational Hierarchy section, for example Division,
Business Unit, Business Subunit, Location, or Regions. The names of these levels may 
vary depending on your configuration. 

3) Click the [Reassign] link next to the Business Unit you want to reassign. 

4) Select a new Business Unit from the drop-down menu. 

5) Click Reassign. 

Creating Hierarchical Relationships 

You can create and manage the relationships between the levels in your organization hierarchy. 
For example, you could create a hierarchical relationship between Division, Business unit and 
Location. You cannot edit these relationships, but you can delete and create new relationships. 

Note: The options you see are set during the initial configuration of your 
system. 

To create a new hierarchical relationship: 

1) Select the Application Configuration tab. 

2) Click the Hierarchical Relationships link. 

3) Click the Create new Hierarchical Relationship button. 

4) Enter a name. 

5) Click to select the combination of levels you want to include in this hierarchical relationship. 

6) Click Create. 
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Configuring Status Reports 

In This Section 

Managing Status Reports ........................................................................................ 77 
Configuring Custom Sections for Project Status Report ........................................... 77 
Managing Key Statuses ........................................................................................... 78 
Managing Keys ....................................................................................................... 78 

Managing Status Reports 

You can use the Manage Status Report page to configure status reports. You can choose the 
sections you want displayed, change the section names, change the name of the submit button, 
and also set the frequency of status reports 

To manage status reports: 

1) Select the Application Configuration tab. 

2) Click the Status Reports link. The Manage Status Report page is displayed. 

3) Select the status report you want to edit. 

4) On the Status Report Configuration section: 

a. Enter a display name for the following: Submit Button, Key Section, Finance Section, 
Project Team Section, Date Section, Notes Section, Reports Sections, Issues Section, 
and Risks Section. Select the Display checkbox to have it display on status reports. 

b. Select the frequency (Weekly, Monthly, or Yearly) you want status reports to be created. 

5) On the Team Member Filter section, select the resource status, roles, and the activity status 
you want displayed on the status report. 

6) On the Issues Filter section, select the status, priority, and severity of issues you want 
displayed on the status reports. 

7) On the Reports Filter section, select the Status, priority, and severity of issues you want 
displayed on the status reports. 

8) Click the Save. 

Configuring Custom Sections for Project Status Report 

EnterpriseTrack allows users to complete and submit status reports for each project. Some of 
the fields included in the status report are pre-defined within the system, but as an Administrator, 
you can specify additional fields that should be part of the weekly status reports. These 
additional fields are added as text boxes to the status report. 

To create and manage project related status reports sections: 

1) Select the Application Configuration tab. 

2) Click the Status Report Sections link. All the available sections are listed. 

3) To modify an existing section, click the Edit link. 

4) To create a new section, click the Create New Section button. 
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5) To delete an existing section, click the Delete link. 

Managing Key Statuses 

You can use the Key Statuses page to set status descriptions for the keys. For each initiative, 
you can create multiple statuses. For example, you can create a status called On Time, or Red, 
or any numeric value that describes the status of keys. 

To create a status for keys: 

1) Select the Application Configuration tab. 

2) Click the Key Statuses link. 

3) Click the Add a New Key Status button. 

4) Enter a description of the status. 

5) Select if you require users to add an explanation for this status. 

6) Click Update. 

To manage statuses: 

1) Select the Application Configuration tab. 

2) Click the Key Statuses link. 

3) To edit the status: 

4) Click the [Edit] link next to the status you want to edit. 

5) Make the necessary changes and click the Update button 

6) To delete a status: 

7) Click the [Delete] link next to the status you want to delete. 

8) Click OK to confirm the deletion. 

Managing Keys 

You can use the Status Report Keys page to create and manage keys that appear on status 
reports. For each initiative, you can configure multiple keys. For example, you can create a key 
called Time or Budget.  

To create a key: 

1) Select the Application Configuration tab. 

2) Click the Keys link. The Status Report Keys page is displayed. 

3) Click the Add a New Status Report Key button. The Create Status Report Key page is 
displayed. 

4) Select an initiative from the drop-down menu. 

5) Enter a name for this key. If you enter Red, Yellow, or Green, the status indicators displayed 
on status reports will display in the corresponding color. 

6) Select if you want this to be an aggregate key. 

7) Enter an order ID. This determines where it is displayed in status reports. 
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8) Click Create. 

To manage keys: 

1) Select the Application Configuration tab. 

2) Click the Keys link. 

3) To edit the status: 

a. Click the [Edit] link next to the key you want to edit. 

b. Make the necessary changes and click the Update button 

4) To delete a status: 

a. Click the [Delete] link next to the key you want to delete. 

b. Click OK to confirm the deletion. 

Calendars 

In This Section 

Managing Calendars ............................................................................................... 79 
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Managing Calendars 

The Calendars section allows you to manage calendars by editing a calendar, copying a 
calendar, viewing calendar usage, and viewing the exception list of a selected calendar. You can 
also create a new calendar from this section, see topic Creating a New Calendar (on page 80). 

Edit a Calendar 

To edit a calendar, follow the steps below: 

1) Click the Application Configuration tab. 

2) Select the Calendars link. The main Calendars page is displayed. 

3) Click the View link next to the calendar you want to edit. The Manage Calendars page is 
displayed. 

4) You can edit the calendar by making changes to the number of working days, the number of 
working hours, or by adding/deleting exceptions. 

5) To delete an exception, click on a date to select it. The Manage Exception pop-up window is 
displayed. Click Delete. 

6) Click Save to save this calendar, or click Save and Close to save and return the main 
Calendar page. 

Copy a Calendar 

To copy an existing calendar, follow the steps below: 

1) Click the Application Configuration tab. 
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2) Select the Calendars link. The main Calendars page is displayed. 

3) Click the Edit link next to the calendar you want to copy. The Manage Calendars page is 
displayed. 

4) Click the Copy button on the top right corner of the screen. 

5) A pop-up window is displayed. Enter a name for this copy. 

6) Select if you want to copy the exceptions. 

7) Click OK. 

View Usage 

To view the calendar usage, do the following: 

1) Click the Application Configuration tab. 

2) Select the Calendars link. The main Calendars page is displayed. 

3) Click the Edit link next to the calendar you want to view. The Manage Calendars page is 
displayed. 

4) Click the View Usage button on the top right corner of the screen. A list of projects and 
proposals that use this calendar are displayed. 

View Exceptions List 

To view the exception list of a calendar, do the following: 

1) Click the Application Configuration tab. 

2) Select the Calendars link. The main Calendars page is displayed. 

3) Click the Edit link next to the calendar you want to view. The Manage Calendars page is 
displayed. 

4) From the Exceptions List tab on the bottom of screen, click the calendar icons to select a 
From date and To date. 

5) Click Apply to view all exceptions in the selected date range. You can click the Reset button 
to reset to a selected month. 

Creating a New Calendar 

To create a new calendar for your organization, follow the steps below: 

1) Click the Application Configuration tab. 

2) Select the Calendars link. The main Calendars page is displayed. 

3) Click the Create button. 

4) A pop-up window is displayed. Enter a name for your calendar and click OK. The Manage 
Calendars page is displayed. 

5) Enter the number of working hours per day. 

6) Choose the status Valid, Invalid, or Archived. 

7) Select Yes you want this to be the default calendar. 
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8) Click to select the working days. From the calendar you can click the tab for each month and 
year. Click on any date to set an exception. The Manage Exceptions pop-up window 
displays. Enter the name for the exception and choose if you want it to be considered a 
working day or a non-working day. Click Save. 

9) Click Save to save this calendar, or click Save and Close to save and return the main 
Calendar page. 

Managing Calendar Field 

Use the Manage Calendar Field link to set a default calendar to use for each initiative 
configured in your system. You can also choose to allow users to change the type of calendar 
they want to use when they create or update a project or proposal. 

To manage the calendar field: 

1) Click the Application Configuration tab. 

2) Click the Calendar Field link. The Manage Calendar Field page is displayed. 

3) Click the [Edit] link next to your initiative. 

4) For the field Allow Calendar to be Updated on Proposal or Project Creation?, select Yes
if you want to allow users to change the default calendar. Select No, if you want users to 
only use the default calendar. 

5) Click Update. 

Routing 

In This Section 

Configuring Idea Routing ......................................................................................... 81 
Configuring Approver Routing ................................................................................. 83 

Configuring Idea Routing 

EnterpriseTrack allows users to quickly create new ideas and convert them into proposals and 
projects. To ensure that the appropriate users get to view idea before they are assigned to an 
owner, the system allows the administrator to create an idea routing scheme. 



Application Administration Guide

82

When a user creates a new idea, it can automatically be routed to an "Idea router" or "Idea 
Assigner". This individual will have the responsibility to review the idea and assign it to an "Idea 
Owner" or "Idea Assignee". 

This functionality becomes infinitely more useful with the ability to create multiple routing 
schemes based on your organizational hierarchy. You can create one global routing scheme 
and then create specific routing schemes for each of your departments.  The routing scheme 
based on the units of the organizational hierarchy will override the global settings. 

For example, let us assume that the global settings specify an Idea Router, but routing scheme 
for the Denver, CO division in the Finance department has a routing scheme that allows ideas to 
be routed directly to an Idea Owner. When a member of the Denver, CO division in the Finance 
department creates an idea, it will get routed directly to the idea owner. All other ideas will get 
routed to the global default Idea Router. 

Create Idea Routing 

Important!

Ensure that you have created users who will be Idea Routers and Idea 
Owners before proceeding with the creation of a new idea routing. 

To create a new idea routing scheme: 

1) Click the Application Configuration tab. 

2) Click the Idea Routing link. You will see a list of all the existing idea routing schemes. 

3) Click the Create a New Idea Routing button. 

4) Select the appropriate organizational units for which this idea routing scheme will be 
applicable from the pull-down menus. 

5) Select whether you want the idea to be routed to an Idea Router or directly to an Idea 
Owner.   

6)  Select the user who will fulfill the position you chose in the previous step. 

7) Enter an Order ID for this idea routing. This will determine the order in which the idea routing 
rules are evaluated. The Order ID should be less than the default global routing scheme. 
You can click the View Existing Order IDs link to view the existing list before entering a 
number in this field. 

8) Click Create to save the new idea routing scheme.  
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Editing Idea Routing 

To edit an idea routing: 

1) Click the Application Configuration tab. 

2) Click the Idea Routing link. You will see a list of all the existing idea routing schemes. 
Locate the idea routing you want to edit and click the [Edit] link in the Action column. 

3) Make the required changes. 

4) Click Update the save the changes. 

Deleting Idea Routing 

The Global idea routing cannot be deleted. To delete one of the other idea routings: 

1) Click the Application Configuration tab. 

2) Click the Idea Routing link. You will see a list of all the existing idea routing schemes. 

3) Locate the idea routing you want to delete and click the [Delete] link in the Action column. 

4) You may be required to confirm the delete action. 

5) Click Ok to delete the selected idea routing. 

Configuring Approver Routing 

Create New Approver Routing 

To create a new approver routing scheme, do the following: 

1) Click the Application Configuration tab. 

2) Click the Approver Routing link. You will see a list of all the existing approval routing 
schemes. 

3) Click the Create New Approver Routing button to display the Create Approval Routing 
page. 

4) From the pull-down menus, select the Initiative, Division, Business Unit, Location, Regions, 
Role and Approver. 

5) Enter an Order ID for this approval routing. This will determine the order in which the 
approval routing rules are evaluated. The Order ID should be less than the default global 
routing scheme. You can click the View Existing Order IDs link to view the existing list 
before entering a number in this field. 

6) Click Create to create a new approver routing scheme. Click Cancel to leave the page 
without saving your changes. 

Edit Approver Routing 

To edit approver routing scheme, do the following: 

1) Click the Application Configuration tab. 

2) Click the Approver Routing link. You will see a list of all the existing approval routing 
schemes. 
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3) Locate the approver routing you want to edit and click the Edit link in the Action column. 

4) On the Edit Approval Routing page make the required changes. 

5) Click Update the save the changes. Click Cancel to leave the page without saving your 
changes. 

Delete Approver Routing 

1) Click the Application Configuration tab. 

2) Click the Approver Routing link. You will see a list of all the existing approval routing 
schemes. 

3) Locate the approver routing you want to delete and click the Delete link in the Action column. 

4) You may be required to confirm the delete action. 

5) Click Ok to delete the selected approver routing. Click Cancel to retain the approver routing 
in the system. 

Configuring Custom fields 

In This Section 

Editing Pre-defined Custom Fields .......................................................................... 84 
Configuring User Defined Custom Fields ................................................................. 85 

Editing Pre-defined Custom Fields 

Pre-defined custom fields are created during the initial configuration your system. You cannot 
create new fields or delete existing fields. As an application administrator, you can only edit the 
existing fields.  

To edit the pre-defined custom fields: 

1) Click the Application Configuration tab. 

2) Click the Custom Fields link. The Manage Custom Fields page is displayed. The fields are 
organized by section e.g., Ideas, Proposal, Project, Program and Resource. 

3) Click the link associated with the section you want to edit, for example Manage Custom 
Fields for Ideas. The Manage Custom Field for Ideas page is displayed. You can use the Set 
Quick Filters for Custom Fields to select if you want to only display fields that are set to 
visible. 

4) Click the [Edit] link next to the field you want to modify. 

5) You can edit the following fields: 

 Field Name: The name for this custom field. 

 UI Section: Select the section within which this custom field should display. For example, 
you can choose to display a project custom field under Basics, Classification, or 
Organization. This option is applicable only if you are configuring custom fields for Ideas, 
Proposals, Projects, or Programs. 

 Visible: Select Yes, if this custom field should be visible to users. 
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 Display on List Pages: Select Yes if you want this custom field to appear on List pages. 

 Display in Filters: Select Yes if want this custom field to display as an option in the Filter 
dialog box. 

 Possible Values: Enter the possible values for this custom field. 

 Sort Possible Values Alphabetically: Select Yes if you want the possible values 
alphabetically sorted when displayed in the UI. 

 Tool Tip: Enter help text. The text you enter is displayed next to the custom field. Users 
can mouse over the Information icon to view the help text. 

 Update Status and Order of Possible Values: For each value select Valid, Invalid, or 
Archived. Values that are marked Valid are displayed in the UI as valid field options; 
invalid field values are not displayed in the system and cannot be used. Archived field 
values are maintained in the system, but are not displayed as valid field options. You can 
also enter a sort order for each value. This order determines the order in which these 
values are displayed in UI. 

 Idea Custom Field Mapping for Proposals or Proposal Custom Field Mapping for 
Projects: Select the Idea or Proposal/Charter field that it maps to. When a proposal is 
accepted and a project is created, the proposal custom fields are copied into the project 
custom fields based on this mapping. 

6) Click Update. 

Notes: 

 You can have one custom proposal/charter field map to multiple 
project custom fields.

 Submit a Service Request to My Oracle Support to change the 
following custom field attributes: Initiative, Field Type, Required, 
Default Value, Sort Order, and Configured.

Configuring User Defined Custom Fields 

To create user-defined custom fields: 

1) Click the Application Configuration tab. 

2) Click the Custom Fields link. The Manage Custom Fields page is displayed. The fields are 
organized by section e.g., Ideas, Proposal, Project, Program and Resource. 

3) Click the link associated with the section you want to edit, for example Manage Custom 
Fields for Ideas. The Manage Custom Field for Ideas page is displayed. 

4) Click the Create a New User Defined Field button. 

5) Enter a field name. 
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Note: If you plan to use the BI Publisher reporting schema to report 
through BIP, the first character of a custom field cannot contain a 
number or special characters, such as * or (. 

6) Choose the type of field you are creating. You can select one of the following types: 
Unassigned, Float (a number with a decimal point), Integer, List, Multi List, Text, Date, 
Currency, Boolean, Notes, Global Resource, Label, Calculated Expression, or Hyper 
Link.  

7) If you selected Calculated Expression as the Field Type, select the type of calculated 
expression you are configuring: Currency, Integer, or Float. 

8) Configure the following optional field setting: 

 UI Section: Select a section within which this custom field should display. For example, 
you can choose to display a project custom field under Basics, Classification, or 
Organization. This option is only available  if you are configuring custom fields for Ideas, 
Proposal, Projects, or Programs. 

 Initiative: Select the initiative that this custom field belongs to. 

 If you selected Calculated Expression as the Field Type, enter an expression: 

 From the Insert from Section drop-down list, select the section you want this field 
to display. 

 From the Field drop-down list, select the fields associated with the expression, 
and click Add. You can enter field names, select operators or symbols to create 
your custom expression.  

 Click Validate, to ensure that the expression is valid. 

 Visible: Select Yes, No, or Context-Sensitive. If you select context-sensitive, then enter 
the conditions when this custom field should be displayed. The Context Sensitive option 
displays only if you are configuring custom fields for Ideas, Charters, and Projects. 

 Display on List Page: Select Yes if you want this field to appear on list pages. 

 Display in Filter: Select Yes if you want this field to appear as an option in the Filters 
dialog box. 

 Required: Select Yes if you require users to enter a value for this custom field. 

 Restricted: Select Yes if you require users with a specific system access profile or 
role(for proposal or project custom fields) to edit the value in this field. For users without 
the designated system-access or role, the field is displayed as a read-only field. You 
must select at least one system access profile or role that can edit this restricted field. 
Required fields cannot be set to restricted. This field setting is not displayed if the field 
type is set to Label or Calculated Expression. 

 Default Value: Enter the default value for this custom field. 

 Minimum: Enter the minimum value for this custom field. 

 Maximum: Enter the maximum value for this custom field. 

 Valid Values: Enter the valid values for this field. To enter multiple values in the Valid 
Values field, enter one value per line. 

 Sort Possible Values Alphabetically: Select Yes if you want the possible values 
alphabetically sorted when displayed in the UI. 
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 Update Status and Order of Possible Values: For each value select Valid, Invalid, or 
Archived. Values that are marked Valid are displayed in the UI as valid field options; 
invalid field values are not displayed in the system and cannot be used. Archived field 
values are maintained in the system, but are not displayed as valid field options. You can 
also enter a sort order for each value. This order determines the order in which these 
values are displayed in UI. 

 Tool Tip: Enter help text. The text you enter is displayed next to the custom field. Users 
can mouse over the Information icon to view the help text. 

 Idea Custom Field Mapping for Proposals or Proposal Custom Field Mapping for 
Projects: Select an Idea or Proposal/Charter field that maps to this Project or Proposal. 
When a Proposal is accepted and a project is created, or when an Idea is accepted and a 
Proposal is created, the custom fields are copied to the Project or Proposal custom field 
based on this mapping. 

Notes:

 You can have one custom proposal/charter field map to multiple 
project custom fields.

 When the Context Sensitive option is chosen, the default field value is 
used for all entities that already exist in the system.

 For custom field values to be maintained when Ideas move to 
Charters, or when Charters move to Projects, the target custom field 
needs to be set to be visible. In addition, for field type List or Multi 
List, the target field (Proposal or Project) must also contain the 
values that are in the source (Idea or Proposal).

 Submit a Service Request to My Oracle Support to change the 
following custom field attributes: Initiative, Field Type, Required, 
Default Value, Sort Order, and Configured.

 The Calculated Expression field type is supported for Ideas, 
Proposals, Projects, Programs, and Activities.

 For context-sensitive user-defined fields, restricted fields are not 
displayed in the Visible only when value in field drop-down list. 

9) Enter a Sort ID. This ID tells the system where it should be located in the list of user defined 
fields. You can click the Order of Existing Fields link to view the existing list before entering 
a number in this field. 

10) Click Create.

Important: You cannot delete custom fields after they are created. You 
can hide the field by selecting No in the Visible field. 

Configuring Pulldown values 

You can use the Pulldown Values section of the Administration module to define various 
items that are displayed in pull down menus throughout the system. Within Enterprise Track 
there can be two types of pull-down values, Global and Initiative-specific. In systems that have a 
single initiative, the 'global' fields will not be distinguished from the initiative specific ones. 
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Global 

In installations that support multiple initiatives within the same system global fields will remain 
the same across initiatives. To configure these values, refer to the topic Configuring Global 
Pull Down Values (on page 88). 

Initiative-Specific 

These fields are initiative specific and can be different for different initiatives within the 
system.  To configure these values, refer to the topic Configuring Initiative-Specific 
Pull-down Values (on page 89). 

In This Section 

Configuring Global Pull Down Values ...................................................................... 88 
Configuring Initiative-Specific Pull-down Values ...................................................... 89 

Configuring Global Pull Down Values 

Within EnterpriseTrack there can be two types of pull-down values, Global and Initiative-specific. 
In systems that have a single initiative, the global fields will not be distinguished from the 
initiative specific ones. 

Creating global pull down values 

1) Click the Application Configuration tab. 

2) In the Global Pull down Values section, click on the type of global pull down value you want 
to create. 

3) You will see a list of the existing values for that category.  

4) Click the Create a New button. 

5) Enter a name for the value. 

6) Enter an order ID. 

7) Click Create. 

Editing global pull down values 

1) Click the Application Configuration tab. 

2) In the Global Pulldown Values section, click on the type of global pull down value you want 
to edit. 

3) You will see a list of the existing values for that category. 

4) Click on the name of the value you want to edit. 

5) In the Edit Pulldown Value for Functional Area page make the required changes. 

6) Click Update. 

Deleting global pull down values 

Once created, the Global pull down values cannot be deleted through the user interface. Contact 
Oracle Customer Support for more information. 
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Configuring Initiative-Specific Pull-down Values 

Within EnterpriseTrack there can be two types of pull-down values, global and initiative specific. 
In systems that have a single initiative, the global fields are not distinguished from the initiative 
specific ones. 

Creating Initiative-Specific Pull-down Values 

1) Click the Application Configuration tab. 

2) In the Pulldown Values section, click on the type of pull-down value you want to create. 
Choose from Note Type, Task Type, Tool Type, Document Type and Metric Type. 

3) Click the Create a New button. 

4) Choose an initiative. 

5) Enter a name for the value. This name will be displayed in the pull-down menus across the 
system. 

6) For Metric Type values: 

a. Select if you want this metric to be the default primary metric. 

b. Enter a low value. 

c. Enter a high value. 

7) If applicable, enter a sort ID for this value. The sort ID determines the order in which the 
values are displayed in the pull-down menu.  

8) Click Create. 

Editing initiative-specific pull-down values 

1) Click the Application Configuration tab. 

2) In the Pulldown Values section, click on the type of initiative pull-down value you want to 
edit. Choose from Note type, Task Type, Tool Type, Metric Type and Document Type. 

3) You will see a list of existing values for each initiative in the system. For example, if you 
selected Task Type you will see a list of the task types that have already been defined in the 
system for each initiative. 

4) Click on the name of the value you want to edit. 

5) In the Edit page make the required changes. 

6) For each value select Valid, Invalid, or Archived. Values that are marked Valid are 
displayed in the UI as valid options; invalid values are not displayed in the system and users 
will be forced to pick a valid value when the entity is edited. Archived values are maintained 
in the system, but are not displayed as valid options. Users can continue to use archived 
values until they change it. 

7) Click Update. 

Deleting initiative-specific pull-down values 

Once created, initiative pull-down values cannot be deleted. They can only be marked as Invalid 
or Archived. 
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Configuring Classification Fields, Resource Pulldown Values and Alignment 
Pulldown Values 

Creating Classification Fields, Resource, and Alignment Pull Down Values 

1) Click the Application Configuration tab. 

2) In the Classification Fields, Resource Pulldown Values, or Alignment Pulldown Values
section, select the type of field you want to create. 

3) You will see a list of the existing values for that category. For example, if you chose 
Functional Area, you will see a list of the functional areas that have already been defined in 
the system. 

4) Click the Create a New Functional Area button. 

5) Select the Bulk Insert checkbox to add multiple values at the same time. 

6) Enter a name for the value. 

7) Select the status (Valid, Archived or Invalid). 

8) Click Create. 

Deleting Classification Fields and Resource Pulldown Values 

1) Click the Application Configuration tab. 

2) In the Classification Fields or Resource Pulldown Values section, select the type of field 
you want to delete. You will see a list of values configured for that category. 

3) Select a value. 

4) Click Delete. 

Deleting Alignment Pulldown Values 

1) Click the Application Configuration tab. 

2) Select Alignment Type.You will see a list of the existing types. 

3) Click [Delete] next to the type you want to delete. 

Note: You can delete values only if they are not in use. 
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Finance Management 

In This Section 
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Managing Currencies 

EnterpriseTrack allows you to configure your system to work with multiple currencies. A list of 
required currencies should be specified during initial system configuration. You can then 
manage these currencies and make them available for use within projects through the user 
interface. 

In This Section 

Creating Currencies ................................................................................................ 91 
Editing and Deleting Currencies .............................................................................. 92 

Creating Currencies 

When you create a new currency through the user-interface, you are, in fact adding a currency 
from the configuration file to the list of currencies available for use within projects. 

To create a new currency: 

1) Click the Finance tab. 

2) Select the Currencies link. The Manage Currency page displays a list of all the existing 
currencies. 

3) Click the Create a New Currency button. 

4) Select the appropriate currency from the Currency pull down menu. The page will refresh to 
pre-populate the other fields with all the available information about that particular currency. 
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5) Make the appropriate changes to the pre-populated information. You can change the names 
the conversion rate as well as the symbol. For some currencies, you may want to enter a 
multiplier. (For E.g., if we assume 1.00 USD = 5000 ZMK, if the US dollar is your base 
currency, you may want to enter 5 in the Conversion rate field and 1000 in the multiplier field. 
This way, users will only need to enter smaller numbers in the conversion rate field and are 
less likely to make mistakes while entering data) 

6) Click Create. 

Editing and Deleting Currencies 

To edit an existing currency: 

1) Click the Finance tab. 

2) Select the Currencies link. The Manage Currency page displays a list of all the existing 
currencies. 

3) Click the Edit link next to the name of the currency you wish to edit. 

4) On the Edit Currency page, make the required changes. The available fields may vary from 
currency to currency and determined by the fields defined within the configuration file. 

5) Click Update to save your changes. 

6) Click Cancel to leave the page without saving any changes. 

Deleting a currency 

To delete an existing currency: 

1) Click the Finance tab. 

2) Select the Currencies link. The Manage Currency page displays a list of all the existing 
currencies. 

3) Click the Delete link next to the name of the currency you wish to edit. 

4) Click Ok in the dialog box to continue with the deletion. Click Cancel if you want to retain the 
currency in your system. 

Note: When you delete a currency though the User-Interface, you are 
not deleting it from the configuration file. You can add this currency to 
the system by using the Creating Currencies (on page 91) link. 

Managing Conversion Rates 

To set monthly conversion rates for currencies that have been created in your system: 

1) Click the Finance tab. 

2) Click the Conversion Rates link. 

3) Select the appropriate currency from the pull-down menu. 

4) Select the year for which the conversion rates are being entered.  

5) Click Add Year to add an additional year of conversion rate values. The default conversion 
rate values are used initially, but you can modify these values. 
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6) Enter the correct rates for each month. To copy the value for a particular month to all the 

subsequent months, you can click the copy forward button . 

7) Click Update. 

Managing Finance Templates 

The Default Global Finance Template is installed when the system is first deployed. You can 
create new global or initiative-specific finance templates by copying and making changes to the 
default finance template. From the Finance Templates section, you can: 

 View details of the finance template. The finance categories and subcategories are 
displayed. You can change the display name, enable or disable finance categories, change 
the multiplication type, and the multiplication factor value. 

 Edit a finance template. 

 Copy a finance template to create a new finance template. 

 Add or update an Import/Export MS Excel template. 

In This Section 

Editing Finance Templates ...................................................................................... 93 
Copying a Finance Template ................................................................................... 96 
Viewing and Editing Finance Categories within a Template ..................................... 96 
Managing the MS Excel Import and Export Template .............................................. 97 

Editing Finance Templates 

To edit a finance template: 

1) Select the Finance tab. 

2) Click the Finance Templates link. All finance templates that are enabled are displayed. You 
can narrow the list by selecting an initiative check box and clicking Go. 

3) Click the Edit link next to the template you want to edit.  

4) Update the template.  

5) Click Update. 

The following settings are displayed on the Finance Template page: 

Finance Template Name: Enter a name for this template. 

Description: Enter a description for this template. 

Finance Tracking Months: Enter the number of months for which financial data is to be 
tracked. 

Default Finance Tracking Start Date: The date from which financial tracking should begin. E.g. 
the Project Start Date or the Planned Project Close Date. 



Application Administration Guide

94

Use Global Finance Lock Month: Select if you want to lock finances using the global finance 
lock month. To set the default global lock month, see topic About Finance Locking. 

Finance Edit Mode: Select the default mode for tracking financial data. You can choose from 
Monthly, Yearly or Aggregate. 

Important

If you choose to allow users to enter an aggregate value for the finances, 
you must specify the Finance Distribution Months (i.e., the entered lump 
sum value is to be distributed over X months). You can also set a 
Finance Distribution Repeat Frequency. 

The system will allow you to switch from the Monthly mode to Yearly or 
Aggregate. You cannot switch from Yearly mode to Aggregate. 

Additional Finance Timescale Display: Select Yearly, Monthly, or Aggregate. This setting 
controls the additional timescale options available in the Timescale field on the Detailed 
Finances tab. If the Finance Edit Mode is Monthly, you can select Yearly or Aggregate; if the 
Finance Edit Mode is set to Yearly or Aggregate, you can only select Monthly. 

Data Entry Mode: You cannot make changes to this field if the template is in use. Select Single 
View (Basic Only) or Double View (Plan and Actual). If you select Double View, two finance 
tables or views are displayed per project: one view for Plan and one for Actual. In Single View, 
only one finance table or view is displayed per project. 

Default Forecast (Forecast) Cutoff Date: Select from Finance Lock Month (from Actual) or 
Current Month. This field sets the default cutoff date that is used as a separator between actual 
values and plan values. 

Proposal Finances Enabled: Select Yes or No. If you select Yes, you can edit and view a 
detailed finance table at the proposal level. 

Finance Distribution Months:  This field is displayed only if the Finance Edit Mode is set to 
Aggregate. Enter the number of months the lump sum value is to be distributed over. 

Resource Computation Enabled: Select if you want to enable resource computation. When 
you enable resource computation, the effort data flows from the activities into the Project 
Finance template. Select No, if you want to import finances from MS Excel. 

Resource Computation Mechanism: Select if you want to convert currency values or 
non-currency values. 

Locked Finance for Open/Closed Projects: The name of the column header for the field that 
displays the financial details for open/closed projects. 

Unlocked Finances for Open Projects: The name of the column header for the field that 
displays the unlocked financial details for open projects. 

Unlocked Finances for Closed Projects: The name of the column header for the field that 
displays the unlocked financial details for closed projects. 

Net Present Value (NPV): Enter a display name and select if you want to enable this field. If 
enabled, these fields appear in the Finance Summary page for each project. This field measures 
the excess or shortfall of cash flows, in present value (PV) terms, once financing charges are 
met. By definition, NPV = Present value of net cash flows. 
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Formula for NPV: value * (1 + (monthly wacc/100)) ^ (-months)) 

Where wacc is the cost_of_capital months. The number of months between the fin track start 
date and the month_date for each of the rows returned by the query. 

Example:

Fin edit mode: Monthly. 

NPV Finance Category: Total = 150 

Saving = 300 

Cost = 150 

Finance Tracking Months: 24 

Finance Track Start Date: Jan/08/2007 

Wacc (cost_of_capital): 7.5% 

NPV = 1,583.98   

NPV for the Finance Edit mode Aggregate is 0. 

Internal rate of Return (IRR): Enter a display name and select if you want to enable this field. If 
enabled, these fields appear in the Finance Summary page for each project. This field 
represents the return rate which can be earned on the invested capital, i.e. the yield on the 
investment. It is defined as any discount rate that results in a net present value of zero of a 
series of cash flows. 

Formula for IRR: value * (1 + (monthly wacc/100)) ^ (-months)) 

Examples:

Fin edit mode: Monthly. 

NPV Finance Category: Total = 150 

Saving = 300 

Cost = 150 

Finance Tracking Months: 24 

Finance Track Start Date: Jan/08/2007 

Wacc (cost_of_capital): 7.5% 

IRR= 1,583.98 

Fin edit mode: Yearly. 

NPV Finance Category: Total = 150 

Saving = 300 

Cost = 150 

Finance Tracking Months: 24 

Finance Track Start Date: Jan/08/2007 

Wacc (cost_of_capital): 7.5% 
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IRR=269.33 

IRR for the Finance Edit mode Aggregate is 0. 

Return on Investment (ROI): Enter a display name and select if you want to enable this field. If 
enabled, these fields appear in the Finance Summary page for each project. This field is the 
ratio of money gained or lost on an investment relative to the amount of money invested. 

Formula for ROI:(Savings ROI - Cost ROI )/ Cost ROI)*100 

Example:

ROI-1 Saving = 300 

ROI-2 Cost = 150 

Finance Tracking Months: 24 

Finance Track Start Date: Jan/08/2007 

Wacc (cost_of_capital): 7.5% 

ROI=1  

Note: These settings are only defaults and can be changed at the 
project level. 

Copying a Finance Template 

To copy a finance template: 

1) Click the Finance tab. 

2) Click the Finance Templates link. 

3) Click the Copy link next to the template you want to copy. 

4) On the Copy Finance Template page enter a new name for the template in the Copy To
field. 

5) Select the initiative to associate with this template. 

6) Click Copy. 

7) To make changes to this template, see topic Editing Finance Templates. 

Viewing and Editing Finance Categories within a Template 

Viewing Finance Categories 

To view the details of the finance template: 

1) Click the Finance tab. 

2) Select the Finance Templates link. 



Finance Management

97

3) From the Action column, click the View details link. All the finance categories and 
subcategories are displayed. 

Editing Finance Categories 

To edit the finance categories 

1) Locate the finance category you want to modify and click the Edit link. 

2) The following fields can be edited: 

 Display Name: The name that is displayed in the user interface. 

 Visible?: Select whether this category should be available for use through the user 
interface. 

 Parent Category: The parent category for this category. 

 Sort ID: The sort order number. This number decides where this category is displayed 
under the parent category. 

 Multiplication Factor Type: You can choose from Static or Expression. 

 Multiplication Factor Value: The multiplication factor applied to the category value when 
data is rolled up to obtain the category totals.    

If you selected the multiplication factor type to be static, this value should be a number, 
typically between 0 and 1.0. If you selected the type to be an expression, the value 
should be an expression in terms of the configured finance constants for your system. 
E.g. cost_of_capital, 1- cost_of_capital. 

 Element Type: The type of element. By default, this is set to Currency. You can also use 
this field to indicate non-currency items, for example: Employee Count or Computers. 

3) Click Update. 

Managing the MS Excel Import and Export Template 

To edit the Excel import and export template: 

1) Select the Finance tab. 

2) Click the Finance Templates link. All finance templates that are enabled are displayed. You 
can narrow the list by selecting an initiative check box and clicking Go. 

3) Click the MS Excel link next to the template you want to edit.  

4) Select if you want to import finances from MS Excel. 

5) Click Browse and select a template file to use. 

6) For the field Excel template file in sync?, select Yes or No. This Excel template file is 
associated with the finance template within EnterpriseTrack. When you modify your finance 
template you should modify the associated Excel template file and upload it to this page. 

7) Click Update. 

Notes: 

 If the finance template is set up to import from MS Excel, users 
cannot manually add or edit finance data. 

 If the Excel file is not in sync, users cannot import and export financial 
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information from their projects. 

Managing Finance Approval Templates 

In This Section 

Working with Finance Approval Templates .............................................................. 98 
Creating a New Finance Approval Template ........................................................... 98 
Viewing and Editing Finance Approval Definitions ................................................... 98 

Working with Finance Approval Templates 

Finance approval templates can be used to dictate the finance approval workflow for projects. 
Finance Approval Templates allow you to configure the approval workflow with greater flexibility. 

There can be multiple financial approval workflows associated with an initiative. If there is only 
one approval workflow template for an initiative, all projects within that initiative will use that 
workflow by default. If more than one approval workflow template exists, users will see a 
Finance Approval Workflow Template pull-down menu when they create a project. 

Creating a New Finance Approval Template 

To create a new finance approval template: 

1) Click the Finance tab. 

2) Select the Finance Approval Templates link. You will see a list of the available approval 
templates. 

3) Click the Create New Finance Approval Template button. 

4) In systems with multiple initiatives, you must select the initiative with which the template is to 
be associated. 

5) Enter a name and description for the template. 

6) Set the Sequential flag to Yes to make the application enforce sequential approvals. 

7) If the Enforcement Status is set to Enforce required finance validations on project close
the application will not allow the project manager to close the project until all the required 
finance approvals are granted. 

Viewing and Editing Finance Approval Definitions 

Viewing Finance Approval Template definitions 

To view the details of a finance approval template: 

1) Click the Finance tab. 
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2) Select the Finance Approval Templates link. You will see a list of the available approval 
templates. 

3) Click the View details link. From the Finance approval definitions page you can add new 
steps, edit or delete existing steps. 

Editing Finance Approval Template Definitions 

1) On the Finance approval definitions page click the Edit to edit details of a finance approval 
step. You can edit the name and description of the approval step. 

2) The Request Optional setting controls how the Request and Approve buttons are displayed. 
If the request is set to optional, approvers can approve without having to wait for a request 
for approval. In this case both Request and Approve buttons are displayed in the project 
finance validation screen. 

3) The Approval Optional setting controls how the Request and Approve buttons are 
displayed. If a particular approval step is required and the approval has to be done is a 
particular sequence then this approval needs to be granted before the Request and 
Approves button for subsequent steps are displayed. 

4) Select the roles that can perform Request, Approve and Undo actions for the particular 
approval step. Multiple roles can be selected by holding the Control key while clicking the 
name of the role. 

Managing Finance Element Types 

Finance element types allow you to define various financial elements and assign a rate per unit 
for that element. For example, you could define an Element type called Man-Hours and assign it 
a rate of $20 per unit. 

This ability to create finance element types allows you to use financial and non-financial inputs 
to calculate financial savings. 

Note: These setting are defaults and can be modified from the Financial 
Settings page for each project. 

Managing Labor Expense Types 

In This Section 

Creating Labor Expense Types ............................................................................. 100 
Editing Labor Expense Types ................................................................................ 100 
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Creating Labor Expense Types 

You can create multiple Labor Expense Types (LETs) based on your business needs. The LETs 
you create are associated with a finance expense category (Capital Expense or Operational 
Expense). Project Managers can use these LETs to label project activities. For example, you 
can create an LET called Training, and associate it with the finance expense category 
Operational Expense. Project Managers can mark activities that relate to training expenses 
under the LET Training. 

To create Labor Expense Types (LETs): 

1) Click the Finance tab. 

2) Click the Labor Expense Types link. The Labor Expense Type List screen is displayed. 

3) Click the Create a New Expense Type button. The Create Labor Expense Type screen is 
displayed. 

4) Enter a name for the LET 

5) Select an expense category from the drop-down list. 

6) Click Add to add a new LET. 

Editing Labor Expense Types 

You can edit Labor Expense Types (LETs) by changing its status and its association with an 
expense category. 

To edit Labor Expense Types (LETs): 

1) Click the Finance tab. 

2) Click the Labor Expense Types link. The Labor Expense Type List screen is displayed. 

3) From the Actions menu, select the Edit link next to the LET you want to edit. The Edit Labor 
Expense Type screen is displayed. 

4) You can change the LET and the expense category from the drop-down list. 

5) Choose the status of the LET. You can select Active, Invalid, or Archived. 

6) Click Update to save your changes. 

Note: You cannot modify an LET that is currently in use. To deactivate 
an LET, you have to change the status to Invalid.

Managing Activity Labor Cost Capitalization Settings 

Enabling Activity Labor Cost Capitalization allows you to select a Labor Expense Type (LET) 
attribute for each activity. Activity labor costs are properly rolled up into finance under 
appropriate expense category (Capital Expense, or Operational Expense) based on its LET. 

For each initiative, you can choose to enable or disable Activity Labor Cost Capitalization, and 
select if you require Project Managers to enter the LET for each activity. You can also set a 
default LET. 

To manage the Activity Labor Cost Capitalization Settings: 
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1) Click the Finance tab. 

2) Select the Activity Labor Cost Capitalization Settings link. 

3) Click the [Edit] link next to the initiative you want to modify. 

4) Select if you want to enable labor cost capitalization. 

5) Select if you require Project Managers to enter the LET for each activity. 

6) Select a default LET. Project Managers can override the default values only if Labor Cost 
Capitalization is enabled. 

7) Click Update to save your changes. 

Updating Global Finance Constants 

The default financial settings are created when your system is first configured. Use the Global 
Finance Constants link to modify the finance constants that were configured for your system. 

To update global finance constants: 

1) Click the Finance tab. 

2) Select the Global Finance Constants link. 

3) Update the global finance settings.  

4) Click Update. 

About Finance Locking 

You can lock finances to prevent changes to project-level finances for auditing, reporting or 
compliance purposes. These locks can be set at the global level, at the initiative level, or at the 
organization hierarchy level.  At the individual project level, users can override this lock if they 
have either the Project Finance Administrator or the Update Project Lock Month permissions. 

Use the Bulk Finance Locking page to: 

 Set the global finance lock month and finance view to lock. 

 Set bulk finance locks for all projects and proposals associated with an initiative or 
organization hierarchy. 

 View, edit, and delete the active finance locks. 

 set temporary finance locks at the global, initiative, or organization hierarchy level. 

Setting Global Finance Locks 

When you set a finance lock, all finance data for all periods up to the lock month will be locked. 
The finances are displayed in read-only mode and users cannot make changes to any value 
within that period. In addition, you can also create a temporary lock for all finance months with 
immediate effect. To view, edit, or delete finance locks, see topic Viewing, Editing, or Deleting 
Finance Locks. 

To create a global finance lock: 

1) Click the Finance tab. 
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2) Select the Bulk Finance Locking link. 

3) From the Global Finance Locking section, select the finance view to lock. You can select to 
the Actual, Plan, Basic or All.  
If your finance template is configured with the Data View Mode set to Single View Basic, you 
can only select Basic as the finance view to lock. You can use Actual, Plane or All if your 
finance template is configured with the Data View Mode set to Double View. 

4) Select the Set Global Finance Lock Month check box. 

5) Select the lock month and enter the year. 

6) Click Update. 

To create a temporary global finance lock: 

1) Click the Finance tab. 

2) Select the Bulk Finance Locking link. 

3) From the Global Finance Locking section, select the Set Temporary Global Lock for All 
Finance Months Now check box. 

4) Click Update. 

Setting Bulk Finance Locks 

You can set a bulk finance lock for all projects associated with an initiative, organization 
hierarchy, or both. All finance data for all periods up to the lock month will be locked. The 
finances are displayed in read-only mode and users cannot make changes to any value within 
that period. In addition, you can also create a temporary lock for all finance months with 
immediate effect. To view, edit, or delete finance locks, see topic Viewing, Editing, or Deleting 
Finance Locks. 

Note: If you have multiple finance locks, then the smallest lock will have 
the highest priority. Organization hierarchy locks will have a higher 
priority than initiative locks, which in turn will have a higher priority than 
global locks. For example, if a project is affected by an organization 
hierarchy lock month and an initiative lock month, then only the 
organization hierarchy lock month will affect the project. 

To create a bulk finance lock: 

1) Click the Finance tab. 

2) Select the Bulk Finance Locking link. 

3) From the Bulk Finance Locking section, select the finance view to lock. You can select to the 
Actual, Plan, Basic or All. 

4) Select an initiative. 

5) Select one of the following Org Hierarchy option: Individual or Relational. Select Individual 
if you want to specify the bulk lock for a specific level of the org hierarchy. Select Relational 
if you want to select more than one level. 

a. If you selected Individual, select an organization hierarchy level and value. 
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b. If you selected Relational, select values for one or more levels. 

6) Select the Set Bulk Finance Lock Month check box. 

7) Select the lock month and enter the year. 

8) Click Update. 

To create a temporary bulk finance lock: 

1) Click the Finance tab. 

2) Select the Bulk Finance Locking link. 

3) From the Global Finance Locking section, select the Set Temporary Global Lock for All 
Finance Months Now check box. 

4) Click Update. 

Viewing, Editing, or Deleting Finance Locks 

To view the active finance locks: 

1) Click the Finance tab. 

2) Select the Bulk Finance Locking link. The active locks are displayed under the Active 
Global and Bulk Finance Locks section. 

To edit a finance lock: 

1) Click the Finance tab. 

2) Select the Bulk Finance Locking link. 

3) From the Active Global and Bulk Finance Locks section, click the Edit link next to the lock 
you want to modify. 

4) Modify the lock settings. 

5) Click Update. 

To delete a finance lock: 

1) Click the Finance tab. 

2) Select the Bulk Finance Locking link. 

3) From the Active Global and Bulk Finance Locks section, click the Delete link next to the 
lock you want to delete. 

4) Click Ok to confirm the deletion. 

5) Click Update. 

Using Bulk Finance Snapshots 

You can capture finance snapshots for all projects or for projects associated with a specific 
initiative or organization hierarchy. For projects that have that the Data Edit mode set to Double 
View, a snapshot of both plan and actual finances are taken. 

To create bulk finance snapshots: 

1) Click the Finance tab. 

2) Select the Bulk Finance Snapshots link. 
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3) Select a snapshot type. You can select the Global or Initiative. If you select Initiative, select 
an initiative from the drop-down menu. If you select Org Hierarchy, select a hierarchy level. 

4) Select one of the following Org Hierarchy option: Individual or Relational. Select Individual 
if you want  to specify the bulk lock for a specific level of the org hierarchy. Select 
Relational if you want to select multiple levels of hierarchy. 

a. If you selected Individual, select an organization hierarchy level and value. 

b. If you selected Relational, select values for one or more levels. 

5) Enter a name for this snapshot. 

6) Enter a description for this snapshot. 

7) Click Create Snapshot. 

Managing Finance Lock Enforcement Settings 

To configure the finance lock settings: 

1) Click the Finances tab. 

2) Select Finance Lock Enforcement Settings link. 

3) Select an initiative and click the [Edit] link next to it. 

4) Select Strict or Limited. 

5) Click the Update button to save you changes. 

Important!

Oracle recommends not changing the enforcement mode on a live 
production system. When the mode is changed, it takes effect only for 
new projects created from that point of time. Old projects continue in the 
previous enforcement mode and cannot be changed. 

Notes:

 In the Limited mode, the finance lock/close period enforcement is 
guaranteed only when roadmap activities are used with Actual Effort 
Type (AET) set to Effort from Finances. Finance lock enforcement is 
not guaranteed when used with any other AET. 

 If finance lock is set to Strict, you cannot change the currency 
exchange rate or labor rates for locked/closed financial periods. For 
roadmap activities, the Actual Effort Type (AET) is restricted to Effort 
at Resource Level (Detail), Effort from Timesheet, and Effort from 
Finances. 

The following table lists the supported options for both the Strict and Limited modes. 

Supported Options Strict Limited

Enforcement Always Guaranteed Not Guaranteed. Guaranteed 
only when used with AET set 
to Effort from Finances, 
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finances are edited in the 
monthly mode, and resource 
rates are explicitly overridden 
at the project level. 

Enforcement is through 
manual process. 

Resource labor rate, 
role, labor rate 
changes 

Not allowed if it can affect a 
finance lock/close period in any 
project. 

System does not check for 
violation and finance 
lock/close period integrity is 
not protected. 

Currency conversion 
rate (exchange rate) 
changes 

Not allowed if it can affect a 
finance lock/close period in any 
project. 

System does not check for 
violation and finance 
lock/close period integrity is 
not protected. 

Supported AETs Effort at Resource Level 
(Detail), Effort from Timesheet, 
and Effort from Finances 

All AET options 

Unsupported AETs Duration& Resource % 
availability, Effort at Activity 
Level- Equal % Distribution, 
Effort at Activity Level- Unequal 
% Distribution, and Effort at 
Resource Level (Summary) 

None 

Editing finances in 
yearly or aggregate 
(annualized) mode 

Not allowed Allowed. Finance lock may 
not be protected. 
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General Settings 
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Company Settings 
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Viewing Account Properties 

Use the Account Properties link to view the account name, SiteWand version, account character 
encoding type, account authentication type, and account time zone. 

To view your account properties: 

1) Click the General Settings tab. 

2) Select the Account Properties link. 

Managing Company Information 

You can use the Company Information page to add your company name, company URL, 
product name and footer.  

To edit your company information: 

1) Select the General Settings tab. 

2) Click the Company Information link. The Edit Company Information screen is displayed. 

3) Enter the appropriate values. 

4) Click Update. 
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Managing Company Logo 

Use the Company Logos page to upload your company logo. You can add a logo to the 
EnterpriseTrack header and the login page. 

To upload you company logo: 

1) Select the General Settings tab. 

2) Click the Company Logos link. The Edit Company logo page is displayed. 

3) Click Browse to find the image. The preferred image formats are JPEG, GIF, PNG and 
BMP. The logo size on the login page is 278 x 80 pixels and the header logo size is 232 x 18 
pixels. 

4) Click Update. 

Managing Default Date Format 

Use the Default Date Format page to select a default date format to use in EnterpriseTrack. 

To select a default date format: 

1) Click the General Settings tab. 

2) Select the Default Date Format link. The Edit Default Date Format screen is displayed. 

3) Select a format from the drop-down list. 

4) Click Update

Managing Default Time Format 

Use the Default Time Format page to select a default time format to use in EnterpriseTrack. 

To select a default time format: 

1) Click the General Settings tab. 

2) Select the Default Time Format link. The Edit Default Time Format screen is displayed. 

3) Select a format from the drop-down list. 

4) Click Update

Internationalism 

In This Section 

Working with the Language Catalog ...................................................................... 108 
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Working with the Language Catalog 

You can use the Language Catalog page to edit the language catalog. If you have customized 
EnterpriseTrack with custom terms or configuration data, you can add or edit the translations 
using the Language Catalog page.  If you have a large number of custom strings that require 
translation, you can export the language catalog as an XLIFF file, translate the strings and 
import it into EnterpriseTrack. 

Notes:

 Oracle recommends that you save a copy of your language catalog in 
each language before you modify the catalog or before you import a 
new language catalog. 

 You must first click the Scan Language Catalog button to ensure 
that the catalog has all static strings that contain the customized 
terms before you begin modifying the language catalog. 

Using the Language Catalog Filter 

To use the language catalog filter: 

1) Select the General Settings tab. 

2) Click the Language Catalog link. The Language Catalog Filter page is displayed. 

3) Click the Scan Language Catalog button. 

4) When the scan is complete, select the filtering criteria from the Language Catalog Filter
page. Since the catalog can contain thousands of terms, it is recommended that you set 
some high level filtering options (e.g. by language, or category) for ease of use. 

5) Choose the number of results you want displayed on each page. 

6) Choose the status (Translated or Not yet Translated). 

7) Click Apply. The Language Catalog page displays a list of terms that meet your criteria. 

Tip: When the list is displayed, you can view the details of the current 
filter by clicking the Show Current Filters icon. You can also filter by 
selecting a language from the displayed options. 

Editing the Language Catalog 

To edit the language catalog: 

1) From the Language Catalog page, click the Edit link next to the term you wish to edit. The 
Edit Language Catalog page is displayed. You may have to navigate through multiple pages 
using the << < > >> keys to locate the correct page. 

2) Make the appropriate changes. 

3) Click the Update button to save your changes. 

Exporting and Importing the Language Catalog 

1) From the Language Catalog page, click the Export button and click OK to save the XLIFF 
file. 
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2) From the Language Catalog Filter page, click the Browse button and select the translated 
XLIFF file, and click Import. 

Notes: 

 PDF reports in Russian, Korean, Japanese, and Chinese are 
displayed correctly only if they are run by users in corresponding 
locales. 

 No user data is translated. For example, project names and 
descriptions are not automatically translated; they are displayed in 
the language of the user that created them. 

 Administration and configuration can only be done in English. 

Help Settings 

In This Section 
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Managing Evaluation and Fields Help 

You can choose to leave the initial configuration setup help as is or you can attach a help 
document (Word, Excel, HTML, PDF etc.), or point users to an URL address. 

To select the type of help you will provide for configuration setup: 

1) Click the General Settings tab. 

2) Select the Evaluation and Fields Help link.  

3) Select an entity and click the Edit link next to it. The Edit Help Type screen is displayed. 

4) Choose the type of help you will provide: 

 Select Initial Deployment Setup to use the initial configuration help. These are the 
descriptions that were entered during the initial deployment. 

 Select Document and click the Browse button to select and upload a document; or 
select URL and type the address. 

5) Click Update. 

Managing User Productivity Kit 

To manage the User Productivity Kit: 

1) Click the General Settings tab. 

2) Select the User Productivity Kit link. The Administration: Manage User Productivity Kit
page is displayed. 
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To change the base URL: 

1) Click the Edit link next to User Productivity Kit Content Base URL. 

2) Select the location of the UPK content: External or Local. Select External, if you want to 
host it from your own server. Select Local, if you want the UPK content to be hosted from 
the same location that the EnterpriseTrack application is hosted. 

3) If you selected External, enter the Base URL of the server hosting the UPK content. 

4) If you selected Local: 

a. Click Browse, and select the published UPK file. 

b. Select if you want only authenticated users to access the UPK content. 

c. Click Upload. 

d. Click Done. 

5) Click Update. 

To change the application identifier: 

1) Click the Edit link next to User Productivity Kit Application Identifier. 

2) Update the identifier and click Update. 

Specifying Online Help URL 

Use the Online Help URL page to specify a new URL location to launch the Online Help when 
help is selected from the application.  If you choose to deploy a local version of the help you can 
enter the URL in the following format: http://<hostname>:port/help/. You can also leave the 
default URL to launch the version of the help hosted by Oracle. Using the hosted version 
ensures that you always have the most current help content.  

To change the default Online Help URL: 

1) Click the General Settings tab. 

2) Select the Online Help URL link. 

3) Specify a new URL location to launch Online Help. 

4) Click Validate. 

5) Click Update. 

Notifications/Emails 

In This Section 

Configuring Notifications ........................................................................................ 111 
Setting Measure Data due Reminder Notification .................................................. 111 
Managing Default Email Addresses ....................................................................... 112 
Setting Stream Ticker Refresh Interval .................................................................. 112 
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Configuring Notifications 

EnterpriseTrack can be configured to send informational and warning notifications to its users. 
As an administrator, you can manage who these notifications are sent to, the reason for the 
notification, and if any action needs to be taken by the recipient. These settings can be 
overwritten at the project level by users with appropriate permissions. 

To manage notifications: 

1) Click the General Settings tab. 

2) Click the Notification Configuration link. You will see a list of notifications that have been 
configured in your system. 

3) Click the [Edit] link next to the notification you want to modify.  

4) From the Edit Notification page, modify the following fields: 

a. Enable Social Stream: Select this check box if you want the notification to be posted to 
the social stream.  

b. Enable Email Notification: Select this check box if you want the notification to be sent 
via email. 

c. Display Login link: Select this check box if you want to display a login link in the email 
notification. This option is displayed only for some notifications. 

d. Display Contact Me link: Select this check box if you want to display a contact me link in 
the email notification. This option is displayed only for some notifications. 

e. Include Area of Expertise, Include Comments, Include Approval Identification Tag: 
Select this check box if you want to display the area of expertise, comments and approval 
identification tags on notifications. The default values are configurable. Note: These 
configurable data fields are only displayed for the Resource Approval Notification. 

f. Email To, Email CC, and Email BCC: Click in the appropriate field and select the roles 
from the Email List menu on the right. You can select multiple entries by holding down 
the Ctrl key on your keyboard. You can also select the roles one at a time and separate 
the values with a comma. 

g. Email Subject: Modify the default text. 

h. Email Body Text: Modify the default message associated with this notification 

5) Click Preview to view the email notification that will be sent out. 

6) Click Update. 

Note: Some notifications are visible only if the associated feature is 
enabled. You cannot add custom notifications. 

Setting Measure Data due Reminder Notification 

Use the Measure Data Due Reminder Notification page to set when notification needs to be sent 
out to remind users that measure data is due.  

1) To set the data due reminder notification: 

2) Click the General Settings tab. 

3) Select the Measure Data due Reminder Notification link. 
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4) Click the [Edit] link next to the frequency you want to change. 

5) Enter the number of days. 

6) Click the Update button to save your changes. 

Managing Default Email Addresses 

You can use the Default Email Addresses link to configure default Email addresses. You can set 
a From address for emails sent by the system, and a Do not reply address. 

To add general Email default addresses: 

1) Click the General Settings tab. 

2) Click the Default Email Addresses link. 

3) Enter the default addresses. 

4) Click Update. 

Setting Stream Ticker Refresh Interval 

To set the refresh interval of the Stream Ticker: 

1) Click the General Settings tab. 

2) Select the Stream Ticker Refresh Interval link. 

3) Click the [Edit] link. 

4) Enter the Refresh Interval in minutes. 

5) Click the Update button to save your changes. 

Report, Listing Page, and Search Settings 
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Managing Max Rows for Reports 

Use the Max Rows For Reports page to limit the number of rows to display in reports. 

To edit the settings: 

1) Click the General Settings tab. 

2) Select the Max Rows for Reports link. The Edit Max Rows for Reports screen is displayed. 
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3) Enter the value. 

4) Click Update

Managing Max Rows for My Work 

Use the Max Rows For My Work page to limit the number of rows to display on the My Work 
page. 

To edit the settings: 

1) Click the General Settings tab. 

2) Select the Max Rows for My Work link. The Edit Max Rows for My Work screen is 
displayed. 

3) Enter the value. 

4) Click Update

Restricting Document Sizes 

To restrict document sizes by initiative: 

1) Click the General Settings tab. 

2) Select the Document Size Restriction link. You will see a list of the current document sizes 
allowed for each initiative. 

3) Click the [Edit] link next to your initiative. 

4) Enter a new value. The sizes are in kilobytes. You can leave the field blank if you do not 
want to restrict the size of the documents. 

5) Click Update to save your changes. 

Configuring Report Attachment Max Size 

To restrict attachment size: 

1) Click the General Settings tab. 

2) Select the Report Attachment Max Size link. 

3) Click the [Edit] link next to your initiative. 

4) Enter a new value. The sizes are in kilobytes. 

5) Click Update to save your changes. 

Selecting Display Mode for Filter Page Sections 

You can set how you want the filter pages to display. You can choose to have the filter section 
all expanded, or all collapsed, or Keep the filter section as is. If you choose Keep The Filter 
Sections As Is, then some of the filter sections are expanded and some collapsed based on your 
earlier settings. All users in the system will see this change. 

To modify the display mode for filter pages: 

1) Click the General Settings tab. 
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2) Select the Display Mode for Filter Page Sections link. 

3) Click the [Edit] link. 

4) From the pull-down menu select from Keep The Filter Sections As Is, Collapsed All, or 
Expanded All. 

5) Click the Update button to save your changes. 

Setting Max Cache Size for Listing Pages 

The cache size refers to the number of rows, or entities (projects, proposal, or resources) 
displayed in listing pages. 

To select the maximum cache size for listing pages: 

1) Click the General Settings tab. 

2) Select the Max Cache Size for Listing Pages link. The Administration: Max cache size for 
listing pages screen is displayed. 

3) Click the Edit link. The Edit max cache size for listing pages screen is displayed. 

4) Enter the cache size. The recommended default value is 1000 rows and the maximum is 
3000 rows. 

5) Click Update. 

Managing Static Application Settings 

Use the Static Application Settings page to modify the following settings: 

 Maximum number of rows to show in filter box

Enter the maximum number of rows to show in the filter box throughout the application. 

 Maximum number of projects to show in filter box

Enter the maximum number of projects to show in the Available Projects filter box. 

 Default number of rows per page

Enter the default number of rows to display per page on listing pages. 

 Limit maximum number of rows per page to

Enter the maximum number of rows to display per page on listing pages. 

 Default working hours per day

Enter the default working hours per day. 

 Display string for TBD user

Enter a display name for TBD user roles yet to be defined. 

 Maximum social stream events to display

Enter the maximum number of social stream events to display on the social stream ticker. 

 Maximum social stream events to display per page

Enter the maximum number of social stream events to display per page on the Social Stream 
listing page. 

 Maximum number of characters in social stream comment

Enter the maximum number of characters allowed in the social stream comment box. 
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 Maximum number of social stream comments to display

Enter the maximum number of social stream comments to display. To view all the comments, 
users can click the View all comments link. 

 Maximum number of time units for scenario

Enter the maximum number of time units to use for scenarios. 

To set the static application settings: 

1) Click the General Settings tab. 

2) Click the Static Application Settings (Max / Min Rows etc) link. 

3) Enter the values. 

4) Click Update. 

Configuring Integration Settings 

Use the Max Records to Retrieve in Integration Searches link to select the maximum number of 
records to retrieve when an external application makes API calls. 

To set the maximum number of records to retrieve: 

1) Click the General Settings tab. 

2) Select the Max Records to Retrieve in Integration Searches link. 

3) Enter the maximum number of records to retrieve. 

4) Click Update. 

Storyboard Reports 

In This Section 
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Adding Storyboard Document Labels .................................................................... 116 

Managing Storyboard Templates 

Use the Manage Storyboard Templates page to download, add, edit or delete storyboard 
templates. You can download the default template files and customize it by adding your 
company logo, changing fonts, or changing the background color.  A storyboard template 
contains a set of style rules that users can apply to their report to format and customize their 
PowerPoint presentations. 

Adding Templates 

To upload your updated or new storyboard templates: 

1) Select the General Settings tab. 

2) Click the Storyboard Templates link. 

3) Enter a display name for this template. 
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4) Click Browse to find your template. 

5) Click Add. 

Downloading Templates 

To download and customize an existing storyboard template: 

1) Select the General Settings tab. 

2) Click the Storyboard Templates link. 

3) Click on the Template File to download it onto your computer. 

Uploading an Edited Templates 

You can change the template display name, replace the associated template file, or 
enable/disable the template. The templates you enable here are available as template options 
when users create project storyboard reports. The templates are edited in Microsoft PowerPoint. 

Note: You cannot edit or disable the default template file. 

To upload an edited template: 

1) Select the General Settings tab. 

2) Click the Storyboard Templates link. 

3) Select the template by clicking on its Template Display Name. 

4) Update the Template Display Name, or click Browse to select and upload a new template 
file, or select the Enable/Disable flag to enable or disable the use of this template. 

5) Click Update. 

Deleting Templates 

To delete a template: 

1) Select the General Settings tab. 

2) Click the Storyboard Templates link. 

3) Click the Delete link associated with the template you want to delete. 

4) Click Ok to confirm the deletion. 

Adding Storyboard Document Labels 

To customize your storyboard document labels: 

1) Select the General Settings tab. 

2) Click the Storyboard Document Labels link. 

3) Edit the description for each of the labels you want displayed on your storyboard. 

4) Click Update. 

Mobile Error Logs 

To view and download mobile error logs: 
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1) Click the General Settings tab. 

2) Select the Mobile Errors link.  

3) Click Download. 

Portal 

In This Section 

Configuring the Welcome Page ............................................................................. 117 

Configuring the Welcome Page 

Use the Welcome Page link to customize the Idea Portal Welcome page. You can add a logo, 
modify the banner, and message. 

To modify the Welcome page: 

1) Click the General Settings tab. 

2) Click the Welcome Page link. 

3) Click Browse and select a custom logo. 

4) Modifying the default banner, message, thank you banner and thank you message. 

5) Click Update. 

Scheduled Reports 

Use the Scheduled Reports link to view all reports that are scheduled to run. From this page, 
you can enable or disable any of the scheduled reports and set the order of report execution. 

To enable or disable scheduled reports or change the order of execution: 

1) Click the General Settings tab. 

2) Click Scheduled Reports. 

3) Enter an order number to set the order in which reports are run. 

4) Select the Enabled check box to enable or deselect to disable a scheduled report. 

Data Import and Export 

You can use the Data Import and Export function to initially populate your account with relevant 
information, import information from your legacy project management tool, and to perform 
recurring updates. 

The high-level steps to import data are: 

1) Download template from EnterpriseTrack for the object you want to import. 

2) Format and enter data into the template. 

3) Upload the template. 
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4) Validate the data. 

5) Import the data. 

In This Section 
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Downloading Data Import Templates 

Importing data into EnterpriseTrack is a multi-step process.  EnterpriseTrack comes with 
pre-defined . csv templates which you must use to format the data to be imported. The system 
will validate the data before it is imported into the system, and check for duplicate records. 

To download the templates: 

1) Click the Data Import & Export tab. 

2) Select the Download Data Import Templates link. 

3) Depending on the primary object (Ideas, Project or User) for which you want to import data, 
click on the appropriate [Download] link. 

4) When the file download dialog box opens up, choose the Save File option and save the file 
to your desktop. 

5) Enter the data to be uploaded in the . csv file. The fields marked with an asterisk (*) are 
required fields and must be entered. 

Once you have completed the template, you are ready to import data into EnterpriseTrack. 

Note: The .csv files needs to be encoded as UTF8, only if the data in file 
is not in ASCII format. UTF8 file formats are generally not compatible 
with MS Excel. 

Modifying Metadata for File Upload 

To modify the metadata details: 

1) Click the Data Import & Export tab. 

2) Select the Modify Metadata for File Upload link. 

3) Choose the type of encoding, delimiter and decimal symbol. 

4) Select if you want to trim trailing and leading spaces. 
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5) Enter the path delimiter and click the Update button to modify the metadata. 

Importing Data 

Importing data into EnterpriseTrack is a multi-step process. EnterpriseTrack comes with 
pre-defined MS Excel templates which you must use to format the data to be imported. You 
must download the template and enter the data into the template before it can be imported into 
EnterpriseTrack. Once you have completed the templates, you can upload it to the system, 
validate the data and then import it into EnterpriseTrack. 

Notes:

 When updating entities, a null value will override an existing value. 

 Values added to calculated custom fields are ignored on import. 

To begin importing data: 

1) Click the Data Import & Export tab. 

2) Select the Import Data link. 

3) Depending on the primary object for which you are importing data, select from Import Ideas, 
Import Project or Import Users. 

Note: If you are importing projects, there are different templates for the 
different sub-sections of the project. You can upload data for each 
section independent of each other. 

4) On the Import (Object) page, click the [Upload Files] link.  

5) Click Browse and select the completed . csv file. 

6) Enter additional attributes associated with the file you are uploading. If you are importing 
finances, select the Finance View (Plan or Actual) to upload.  

7) Click the Upload. The system will tell you how many records were successfully uploaded. 

8) Once the file has been uploaded, click the Validate Data button. On the Validate Data page, 
you can specify whether you want to allow changes to be made to the existing data or not. 
Click the Validate Data button. The system will work though the records and display a count 
of the records that have errors. All errors have to be fixed before the data can be imported. 

9) Click the Delete Files button to delete an existing file and import a new one. Once data has 
been validated, you will have to delete the file before uploading a new one (even if you are 
only fixing errors). 

10) Click the Import Data button to import the data. On the Import Data page, you can specify 
whether you want to allow changes to be made to the existing data or not. Click the Import 
Data button. 

11) The imported objects should be visible in the appropriate listing pages. 
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Notes:

 You cannot import finances for projects using a finance template that 
have the setting Resource Computation Enabled set to Yes. 

 When uploading incremental finances, you must set the field Allow 
Updates to Existing Data to Yes for the values to get updated. 

Viewing Error Records 

1) Click the [View Error Records] link to view a list of the records with errors. 

2) A dialog box will ask you if you want to open a file. This file will give you the name of the 
record as well as the column that has the erroneous data. E.g. If the contact information has 
not been formatted properly for a particular idea, the Error Message will say Contact. 

Common Validation Errors 

The following table lists some common validation errors that may occur when importing or 
exporting entities. 

Validation Error Description 

Role Import - Role is not part of the initial 
project team 

The roles you want to import must be part 
of the initial project team for team 
members to be imported into the role on 
the project.     

The template to import team members 
is  et_dataimport_csvtemplate_project_tea
m and it requires a minimum of 3 columns: 
project_key[*],  role_desc[*Role 
Description], login_id[*Login Id] 

Project Import – Duplicate Project Names 
or IDs are not allowed 

There is already a project in the system 
with this name, and the setting Allow 
updates to existing data is turned off for 
this project. 

The Project Key should be unique across 
all projects.  

Project Import – Calendar Column is 
missing 

Calendar is a required field for project 
import. Add this field before importing. 

Project Import – Mandatory Data is 
missing  

Finance Approval Template and Project 
Validate Date are required fields. Specify a 
valid financial approval template and a 
project validate date for this project. 
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Unlocking a Data Import Process 

Use the Unlock Data Import Process page to unlock an import process that is locked. An import 
process can get locked if you navigated to another screen, closed the window, the session timed 
out, or the connection failed during an import.   

Notes:  

 The Unlock Import Data Process link is visible only when a data 
import process is locked. 

  Only the administrator that initiated the import process can unlock it. 
Submit a Service Request to My Oracle Support if you need 
assistance.

To unlock a data import process: 

1) Click the Data Import & Export tab. 

2) Select the Unlock Import Data Process link. 

3) Click Yes to unlock the process. 

Exporting Data 

To export data: 

1) Click the Data Import & Export tab. 

2) Click the Export Data link. 

3) From the Action column associated with the primary object (Idea, Project, Resource, etc.) 
you want to export, select the [Export Data] link. 

4) From the Last Modified Date picker, specify a date. All objects that were updated on or after 
the specified date will be exported. If no date is specified, all data is returned. When 
exporting Measure, the Last Updated Measure Data is used. 

5) For Monthly Finance and Annual Finance, enter the project IDs or a range of project IDs and 
click Export. If no project IDs are specified, a maximum of 100 projects are exported. 

6) Select if you want to open or save the file. Choose the location and click OK. 

Downloading Data Integration Templates 

You to download two types of templates in real-time for a project, finance, resource, team 
member, WBS, non_WBS, and assignment entities, based on your EnterpriseTrack account 
configuration. They are: 

 Templates for the CRUD functions. 

 Templates for request data for the CRUD functions. 

To download the CRUD templates: 

1) Click the Data Import & Export tab. 

2) Select the Download Data Integration Templates link. 

3) Select values for the following fields from the corresponding drop-down list: 
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 Languages: Select your language. English is displayed by default. 

 Data Format: Select the data format in which the function is to be rendered. Choices 
include: JSON, and XML. 

 Type: Select the type of template that is to be downloaded. Choices include: 

 Download Template: Generates CRUD templates in XML and JSON formats. 

 Download Request for Template: Generates a request template in XML and 
JSON formats for each CRUD function. These request templates can be used to 
specify input data in the relevant CRUD function. 

 Initiative: Select the initiative, if you are downloading a template for project, team 
member, activity WBS or activity non WBS entities. 

 Finance Template: Select the finance template, if you are downloading a template for 
Project Finance Data or Project Finance Snapshot Data entities. 

 Activity Type Name: Select the activity type, if you are downloading a template for 
Activity WBS or Activity Non WBS entities. 

4) Click the Download button for the corresponding function. 

If you chose Download Template, a create_request, update_request, search_request 
and delete_request file will be generated. 

If you chose Download Request for Template, the following files will be generated: 
create_request_template, update_request_template, search_request_template and 
delete_request_template. You can use these files to specify input data for the relevant 
CRUD function. 

Populate Resource Commitment Cache 

Use the Populate Resource Commitment Cache link to clear and repopulate the resource 
allocation commitment cache. To use this, you must have the following settings enabled: Enable 
Allocation Units for Resources and Enable Effort Caching For Resource. 

To populate the resource commitment cache: 

1) Click the Data Import & Export tab. 

2) Click the Populate Resource Commitment Cache link. 

3) Click Start Processing. 

Background Jobs 

In This Section 

Viewing Rate Change Status ................................................................................. 123 
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Viewing Rate Change Status 

The Rate Change Submission Status page displays the status of all rate change requests in the 
last 7 days. 

To view the submission status of all rate change requests in the last 7 days: 

1) Click the Background Jobs tab. 

2) Select the View Rate Change Submission Status link. 

Using Activity Labor Cost Capitalization 

The Activity Labor Cost Capitalization feature allows you to add Labor Expense Type (LET) 
attributes to project activities. These LETs are mapped to finance expense categories like 
(Capital Expense or Operational Expense). Activity labor cost is properly rolled up into finance 
under appropriate expense category based on its LET. 

Important!

Follow the configuration steps carefully to ensure proper labor cost 
roll-up from activities to finance. Please contact Oracle Customer 
Support if you have any questions. 
Set up the Finance Template to include all the sub-categories like 
standard effort, overtime effort, timesheet effort and timesheet overtime 
effort even if you are not currently using these categories. Labor cost 
data may not roll-up properly if the template is not set up as per the 
recommendations. 

To setup and configure Activity Labor Cost Capitalization: 

1) Modify the Finance Template. 

1. Ensure that the Finance Template has a separate category for Capital Expense and 
Operational Expense. 

2. The Capital parent category should include a sub-category Resource Capital Expense
of type Capital Expense-Resource Activity based Finance Category. It should include all 
standard effort, overtime effort, timesheet effort and timesheet overtime effort. 

3. The Expense parent category should include a Resource Operation Expense
sub-category of type Operational Expense-Resource Activity based Finance Category. It 
should include all standard effort, overtime effort, timesheet effort and timesheet overtime 
effort. 

4. The Expense parent category should include a Resource Neutral Expense
sub-category of type Resource based Finance Category.  It should include all standard 
effort, overtime effort, timesheet effort and timesheet overtime effort. 

5. Set the field Resource Computation Enabled to Yes. 

2) Create Labor Expense Types (LETs) based on your company's business needs. See topic 
Creating Labor Expense Types (on page 100). 

3) Set a default LET in the activity template. For more information, see topic Creating Activity 
Templates (on page 59). 
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4) Manage the Activity Labor Cost Capitalization Settings. For more information, see topic 
Managing Activity Labor Cost Capitalization Settings (on page 100). 

1. Select Yes for the field Labor Cost Capitalization Enabled. 

2. Select Yes for the field Is Labor Expense Type required for Activities. Oracle 
recommends that you mark Yes for this field if you have enabled Labor Cost 
Capitalization. 

5) Enable Project Level Efforts. 

6) Edit project finance settings. Ensure that the Project Manager has enabled these settings. 

1. The Finance Tracking Start Date should be the same date as the project start date. The 
actuals will not flow if they are not the same. 

2. Select Yes for Resource Computation Enabled. 
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